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Chapter 1. HCL Nomad for web browsers 1.0.x User
Documentation

HCL Nomad is a client that allows users to work with Domino applications from their mobile devices and

web browsers.

Nomad for web browsers is a Progressive Web Application (PWA), which enables native application
features, such as being independent of connectivity and providing an OS icon/link. These features may

vary per supported web browser.
What's new in HCL Nomad for web browsers (on page 3)

© Copyright HCL Technologies Limited 2020, 2021

What's new in HCL Nomad for web browsers

Release 1.0.17
« Display clarity on high resolution displays

Canvas elements on high resolution displays are now rendered at higher resolution (matching the

web elements).

* Reworked Nomad server on Domino login
For non-0IDC and non-SAML authentication configurations with Nomad server on Domino, the ID
password is now required to access the Nomad client after initial setup when the Nomad client
is reloaded or logged out. Previously, only the user name was required for accessing the Nomad

client. The OIDC and SAML flows remain unchanged. The NRPC traffic is independent of the

access flows, remains unchanged and is still encrypted.

Release 1.0.16

* LotusScript access to C API
« Spell Check

Spell check has been added for the following languages:

Catalan (ca), Czech (cs), Danish (da), German (de), English (Australia) (en-AU), English (UK) (en-
UK), English (en), Spanish (es), Finnish (fi), French (fr), Hungarian (hu), ltalian (it), Norwegian
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Bokmal (nb), Dutch (nl), Polish (pl), Portuguese (pt), Russian (ru), Slovenian (sl), Swedish (sv), Thai
(th), Turkish (tr).

» COM Helper for Microsoft Edge
Component Object Model (COM) calls from agents and buttons can now be utilized on Windows

client machines via a COM Helper with Microsoft Edge. For more information, see COM Helper (on

page 61).
Release 1.0.15 IF1
* Bug fixes. For more information, see HCL Nomad for web browsers 1.0.x Release Notes.

Release 1.0.15

* Restyle in all Nomad languages

Restyle is no longer limited to English only.

+ Designer in all Nomad languages

Designer is no longer limited to English only.

- Sametime Integration

Sametime integration enables two integration features with HCL Sametime. It displays the number
of unread messages in the navigation bar via a new button to open Sametime. Clicking on names
opens a business card for the user, displaying contact info and a chat button to open Sametime

chat with that user. See Sametime Integration (on page 69) for more details.
« View Attachments
For any attachments that the browser can render, the View option is enabled. Any attachments that

require more than just the browser to render are still download only. For additional security options,

see Three click support in HCL Notes documentation.
» COM Helper for Google Chrome
Component Object Model (COM) calls from agents and buttons can now be utilized on Windows

client machines via a COM Helper with Google Chrome. For more information, see COM Helper (on
page 61).


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289
https://help.hcl-software.com/notes/14.0.0/client/three_click.html
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Release 1.0.14

« Initial Setup Improvements

Various steps in the initial setup have been improved by doing more operations in parallel with
other operations to reduce overall setup time. Additionally, the service worker workaround step for
Firefox (/ffswwa) has been removed.

« Content-Security-Policy updates
The Content-Security-Policy header script-src and style-src directives have changed to be more
restrictive. If you are using Nomad server on Domino and have not customized the Content-
Security-Policy header, no change is needed. If you have customized the Content-Security-Policy
header, you should update the customized value based on Configuration options for the Nomad
server on Domino in the Nomad Administration documentation. If you are using SafeLinx as your

Nomad server, you should update the Content-Security-Policy header based on Hosting the Nomad
for web browsers static web files in the Nomad Administration documentation.

Release 1.0.13 IF2

* Bug fixes. For more information, see HCL Nomad for web browsers 1.0.x Release Notes.
Release 1.0.13 IF1

« Bug fixes. For more information, see HCL Nomad for web browsers 1.0.x Release Notes.
Release 1.0.13

- Single executable for Nomad server on Domino
> There is now only one executable for Nomad server on Domino that works on all supported
versions of Domino rather than multiple executables per Domino version.

! Important:
Review the required configuration changes when upgrading to the new version in

Nomad server on Domino Configuration options for the Nomad server on Domino.

« SAML configuration for Nomad server on Domino

The SAML configuration that used to be specified in nomad- confi g. ym must be migrated to
i dpcat . nsf. This cannot be migrated automatically because of the key exchange that occurs


https://help.hcl-software.com/nomad/1.0_admin/config_options.html
https://help.hcl-software.com/nomad/1.0_admin/config_options.html
https://help.hcltechsw.com/nomad/1.0_admin/hosting_static_files.html
https://help.hcltechsw.com/nomad/1.0_admin/hosting_static_files.html
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289
https://help.hcl-software.com/nomad/1.0_admin/config_options.html
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during the SAML configuration process with Domino and the IDP. For more details, see Configure

SAML authentication for Nomad server on Domino.

* Retrieve the Notes ID using Domino HTTP as an OIDC provider

If Domino HTTP is configured to use an OIDC provider for federated login, that mechanism can be
used with Nomad for federated login to retrieve the Notes ID file too (requires the Domino servers
running HTTP and the ID Vault to be at least Domino 14.0.0 FP2).

« Drag and Drop

Drag and drop is no longer limited to Chrome and Edge.

» Modernization updates
o Custom Application Builder: Create a new application with fundamental components such
as a view, form, and action bars created automatically. For more information, see Custom
Application Builder (on page 53).
> Import Restyle settings: Import Restyle settings from a previously restyled database. For
more information, see Importing Restyle settings (on page 58).
» Nomad Design support for a new Formula Function

Support for a new Formula Function @canBar code. For more information, see Designer Formula

@Functions (on page 59).
Release 1.0.12 IF1
« Bug fixes. For more information, see HCL Nomad for web browsers 1.0.x Release Notes.
Release 1.0.12

* Nomad Designer Preview

When a frameset, page, form, view or folder is selected, Design > Preview opens the element in the
main Nomad window with a new header that allows the element to be viewed in desktop, phone or
tablet sizes and with varying orientations. This allows a designer to test the responsiveness of their

design without launching on a real device.
* Log in using Domino HTTP as an OIDC Provider
If Domino HTTP is configured to use an OIDC Provider for authentication, that mechanism can be

used with Nomad for authentication too (requires the Domino server running HTTP to be at least
Domino 14.0.0 FP1).


https://help.hcl-software.com/nomad/1.0_admin/config_saml_for_nomadserver.html
https://help.hcl-software.com/nomad/1.0_admin/config_saml_for_nomadserver.html
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289

HCL Nomad for web browsers User Documentation | 1 - HCL Nomad for web browsers 1.0.x User
Documentation | 7

Note:
This does not apply to the Notes ID operations, so the user must still provide their Notes ID

password to connect to the Domino server.

* New Workspace

The Workspace layout is updated to a more recent version (already utilized by the Notes client for
multiple releases). This includes a new tile layout, updated fonts, updated database icons, folders

on the left, and customizable backgrounds.

- Drag and Drop

Drag and drop support for dragging mails between folders is extended to add addresses on the
Select Addresses dialog, files into a rich text field, selected text within a rich text field, and folders
in the Inbox view. Drag and drop support remains limited to the Chrome or Edge browsers.

« Additional Fonts

When using a Chrome or Edge browser, the user may give permission for Nomad to access
operating system fonts which will then be used for font rendering purposes as long as the font
supports regular, bold, italic, and bold+italic.

* Log in as different user

If Nomad Shared Login is disabled, users now have an additional option to Log in as different user
on the Notes ID Password dialog that is shown on each startup if NSL is disabled.

- Domino Restyle updates:
> When restyling selected design elements in an application, Subforms are now a separate
option.
> The restyle dialog now displays the name and date/time of the most recent restyle (if any).
- Keeping applications restyled:
= When editing an application that has been restyled, adding new forms, table style
views, or framesets create them with restyled properties.
= When adding buttons, sections, or tables to a form (or page or subform) to a restyled
application, they are added as if they are already restyled.
> General Modernization updates:
= The default icon is now the current Notes icon, when creating a new, blank database.
= A new option Create Custom is now available when creating a new application. It
creates a new database with a standard frameset and outline as well as a default
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view. The user can set the theme for the application and design their own icon. As
this new application is considered restyled, new elements added to the application

apply restyle styling in most instances.

Release 1.0.11

- Attachments in Firefox support
File attachments are now supported in Firefox, so file attachments are now supported by all
supported browsers.

« Color picker updated

The color picker has been replaced with a more functional color picker.

 ACL dialog

The Access Control List dialog is now available.

- Domino Restyle updates:
- Designer: There are two new actions available in Designer when viewing the design element
lists: Restyle and Restyle Fonts. These actions are visible after a database has been restyled

once using the Restyle Wizard.

File Edit View Create Design

Jesign X

~| NewForm | [T]Restyle [ |RestyleFonts |/~ Sign

Name <

Anonymous Response

= Restyle invokes the "Restyle" function on the design elements selected in the list. The
Restyle options from the previous full Restyle operation are used in this context.

= Restyle Fonts invokes the "Restyle" function but only updates the fonts using the
settings selected from the previous full Restyle. This action leaves all other design
attributes on the selected design elements untouched. Both actions are available for
Framesets, Pages, Forms Views, Folders, Outlines, Subforms, Fields and Columns.

> When restyling a copy, select Make a new copy, so that | can test restyle from scratch
to start from a fresh copy, removing the old copy you had been working on. For more

information, see Making a copy of an application in Restyle (on page 47).
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> Choose whether or not About Application document and Using Application document

elements should be restyled. Previously, About and Using documents were automatically

restyled. The current default is to restyle them (checked), but they can be deselected if

desired.

Restyle the following elements

E @@ A

Forms

Fields on forms
Fages

Views

Folders

Framesets

Action bars
Embedded outlines
Mavigators

| About Application document

Using Application document

- Shared, private on first use, and private views and folders that are stored in the database will

also be restyled.

o Restyled action icons may be selected for applications that are not restyled. Previously,

restyled applications received updated action icons. For more information, see Updating

icons with Restyle (on page 48).

> A new Flat button style is available for buttons on forms, pages, and documents. This style

is similar to a Rounded button, but draws the focus around the button in an updated style.

The Flat button style is available for all applications. If the application has been restyled, a

new button will automatically be created with the Flat style, with a color that matches the

application color, and a contrasting text color. If the application has not been restyled, the

button will be blue with white text, as shown below.
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Style
Bl #0066B0

Flat v

T

flat button

Release 1.0.10

* Nomad Designer
Use HCL Nomad Web to design Notes databases. For more information, see Designer (on page
58).

« Send mail offline
Sending mail offline via a local mail.box is now supported. For more information, see Offline mode
(on page 31).

« Support for HTTP connections
Nomad server on Domino supports HTTP connections in addition to the previously supported

HTTPS connections. For more information, see the section on Connect to reverse proxy through
HTTP protocol in the Nomad Administration documentation.

- Support for optional HTTP headers

Nomad server on Domino supports adding optional HTTP headers to the response.
« Support for Let's Encrypt flows
Nomad server on Domino supports the Let's Encrypt flows for certificate handling. For more

information, see the section on Support Let’'s Encrypt HTTP-01 challenge requests in the Nomad

Administration documentation.

+ Added language support

Language support for Catalan (ca), Czech (cs), Hungarian (hu), Slovenian (sl) and Thai (th).

» Domino Restyle updates:


https://help.hcltechsw.com/nomad/1.0_admin/using_reverse_proxy.html
https://help.hcltechsw.com/nomad/1.0_admin/using_reverse_proxy.html
https://help.hcltechsw.com/nomad/1.0_admin/config_options.html
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> Customize theme colors with Restyle palette definitions. For more information, see
Customizing theme colors with Restyle (on page 41).

- Assign different colors, borders, and other properties to the design components to create
alternatives to a colorful action bar, with a simple or dark outline. You can rewrite the
entire theme, modify a single property, or anything in between. For more information, see
Customizing themes with Restyle (on page 37).

> Restyle now offers the option to make a copy of an application to restyle, rather than
needing to restyle the original application. For more information, see Making a copy of an
application in Restyle (on page 47).

- Update action icons and selection markers via the Update standard action and view icons
setting. Selection markers can also be updated via the Designer View property. For more
information, see Updating icons with Restyle (on page 48).

o Performance improvements.

Release 1.0.9

« Information box support

Information boxes are used to show Application Properties, Document Properties, Database
Properties, Text Properties, Workspace Properties, etc. Rather than being a free floating dialog as
the information box is in HCL Notes, the information box is shown docked on the right side.

« File > Import has been enhanced to support more previously unsupported file types. For more
information, see Limitations (on page 71).

« Domino Restyle updates:
> User-supplied themes.

Restyle can now utilize user-supplied themes stored in a shared database. For more

information, see Customizing themes with Restyle (on page 37).

- Users can import an application icon. For more information, see the bullet on the fourth tab
- Create icon in Domino Restyle for Notes applications in the Notes documentation.

o Shared fields and shared columns are now restyled. For more information, see Restyle
Limitations in the Notes documentation.

o Users can optionally apply updated icons for action buttons and view column icons. For
more information, see the third tab - Confirm settings segment of the Domino Restyle for

Notes applications topic in the Notes documentation.


https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html
https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html#domino_restyle_applications__section_jr4_sc4_y5b
https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html#domino_restyle_applications__section_jr4_sc4_y5b
https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html
https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html

HCL Nomad for web browsers User Documentation | 1 - HCL Nomad for web browsers 1.0.x User
Documentation | 12

> Restyle only selected portions of the application. For more information, see the third tab -
Confirm settings segment of the Domino Restyle for Notes applications topic in the Notes
documentation.

» Restyle can now utilize user-supplied typography. For more information, see Customize
typography with Restyle (on page 43).

Release 1.0.8

- Warning for Memory Saver to avoid potential data loss. For more information, see Optional
browser configuration (on page 23).

« Open in New Window feature. For more information, see Optional browser configuration (on page
23).

« Firefox now supports replication and offline mode.

For more information, see:
> Replication (on page 30).
o Offline mode (on page 31)
o System requirements (on page 18)
« Notes Shared Login (NSLv3) can be disabled:

When disabled, the user will be required to enter the ID password each time Nomad is run and there
will be an additional profile menu entry for managing the password. For more information, see

Using Nomad Shared Login to suppress password prompts in the Domino documentation.

- N
Note:
For the Nomad section of the Security Settings document to be shown in the Domino
Administrator when running a 12.0.2 pubnames template version, $$TEST_NOMADSL=1
must be set in the notes.ini for Domino Administrator. Future versions of the template will
always show the Nomad section, so $$TEST_NOMADSL=1 is only necessary until the

next version of the template is released and then $$TEST_NOMADSL=1 will be obsolete.
- J

« User Interface improvements to the Find Dialog:

There are many improvements to the Find Dialog including adding an X of Y adornment.
» Domino Restyle updates:

o Restyled fields.

Fields on forms are now restyled, depending on their type and properties. For example, a
text or number field will render in the same way as an OS edit control, replacing the small


https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html
https://help.hcltechsw.com/domino/12.0.2/admin/secu_use_nomad_shared_login_to_suppress_pw_prompts.html
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open and close brackets with a native edit control. Dialog lists that do not allow multiple
values are converted to OS comboboxes, while dialog lists that do allow multiple values are
not. Updating the look of these fields gives an updated look to the form.

> User-defined application colors.

You can now create your own application colors to be used when restyling applications with
the Restyle feature. For more information, see Defining application colors with Restyle (on

page 35).
Release 1.0.7

- Capture signature:

Capture a hand written or typed signature image using a Rich Text Lite field enabled for signature.
For more information, see the following topics in the Domino Designer documentation:
o Signature add-on to Rich Text Field
o EditInsertSignature @Command (Formula Language)
» Domino Restyle updates:
- Create an application icon.

To create an icon, select File > Application > Restyle. In the dialog, you can customize the

illustration, shape, and color of the icon.

> Choose a custom color (previously, app authors could pick from a fixed color list).
- Convert an existing database to use the standardized layout.
« Improved support for Domino policies.
o HCL Nomad now has improved support for Domino Policies. Policy settings are applied at

initial setup and each time the application is restarted.

Note:

Not all policy settings have been tested with HCL Nomad clients.

« If the optional Content-Security-Policy header is in use, the font-src directive must be added and
the script-src directive should be updated. For more information, see Hosting the Nomad for web
browsers static web files in the Nomad Administration documentation.

* Bug fixes. For more information, see HCL Nomad for web browsers 1.0.x Release Notes.


https://help.hcltechsw.com/dom_designer/12.0.2/basic/wn_signaturesupportforrichtext.html
https://help.hcltechsw.com/dom_designer/12.0.2/basic/H_EDITINSERTSIGNATURE.html
https://help.hcltechsw.com/nomad/1.0_admin/hosting_static_files.html
https://help.hcltechsw.com/nomad/1.0_admin/hosting_static_files.html
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289
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Release 1.0.6

» Domino Restyle updates:
> Navigators in the application are restyled.
o Applications can choose to change their launch property to a standardized frameset. For
more information, see Launch property features (on page 34).
- panagenda MarvelClient updates in the Analyze Database:

Additional information is now returned from the browser and reported in the Analyze Database:
> browser name
o browser version
° 0S name
° 0S version
o user agent string

« Nomad server on Domino on Domino 12.0.2:

Nomad server on Domino now runs on Domino 12.0.2 in addition to 12.0.1.

* Bug fixes.

Release 1.0.5

- Domino Restyle

Domino Restyle updates an application's Ul elements with a color-coordinated, cleaner look and
feel. With Restyle, only Ul elements are updated; no code is modified. To access the Restyle option,
select File > Application > Restyle for a selected application or workspace icon. Designer access to

the application is required to use Restyle.
For more information, see Domino Restyle for Notes applications in the Notes documentation.

Note:

Restyle is available initially only in English; therefore, the browser language must be set to

English for Restyle to appear.

« Nomad server on Domino

HCL Nomad server on Domino is an alternative for HCL Nomad clients to communicate with
the HCL Domino servers. Using the HCL SafeLinx Nomad proxy server (previously required) is
now optional. For more information, see Nomad server on Domino in the Nomad Administration

documentation.


https://help.hcltechsw.com/notes/12.0.2/client/restyle_applications.html
https://help.hcltechsw.com/nomad/1.0_admin/nomadserver_domino.html
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o ™
Note:
Either HCL Nomad server on Domino or HCL SafeLinx is still required for HCL Nomad
clients communicating via WSS (WebSocket Secure). For more information, see System

requirements (on page 18).
N J

* Redesigned Group Tabs
Tabs associated with databases and documents in those databases have been redesigned. This
includes grouping tabs per database and updated appearance of tab components.

- panagenda MarvelClient Nomad Roaming
Nomad Roaming allows users to maintain a consistent workspace across your HCL Nomad
clients. Workspace backups can be stored in a central Analyze database on the Domino server,

restored every time a Nomad client starts, and can sync two Nomad clients as they are running. For

more information, see panagenda's Nomad documentation.

* Nomad handling of not es: / / links

Notes links (links using the not es: / / protocol) can now be handled by Nomad if you register
Nomad to be the protocol handler in the operating system. To assist in this enablement, Nomad
includes instructions and relevant files in a sub-directory. For more information, see Notes links (on
page 29).

Release 1.0.4

« Replication (on page 30).

Replication is now fully supported with browsers of the required level. For more information, see

System requirements (on page 18).

« Offline mode (on page 31).

Users may continue working in local replicas without interruption if the connection is lost.

Release 1.0.3

« Language support for Danish (da), Finnish (fi), Norwegian (nb), Turkish (tr).
» Document printing support. For limitations on document printing, see Limitations (on page 71).

- Application switcher.


https://www.panagenda.com/kbase/display/mc/Nomad+Roaming+Overview

HCL Nomad for web browsers User Documentation | 1 - HCL Nomad for web browsers 1.0.x User
Documentation | 16

Application (app) switcher is an optional, configurable dropdown menu displayed on the left of
HCL Nomad for web browsers' navigation bar. Each app switcher menu entry shows an application
icon followed by the application’s name. Clicking on an app switcher menu entry navigates to the

corresponding application address in a new browser tab.
For more information, see Configuring application switcher in the Nomad Administration
documentation.

+ Shared usage (on page 26).

You can preserve multiple users’ data when Nomad for web browsers is being accessed on a

shared computer.
For administrators, see Shared usage (Nomad for web browsers) in the Nomad Administration
documentation.

« LotusScript NotesGPS class support.

For more information, see NotesGPS (LotusScript) in the Domino Designer documentation.
* Tech Preview: Replication.
This feature will be generally available in a future release, as it relies on a Google Chrome feature

that has not been generally released. To enable this feature, follow the steps in Replication (on

page 30).
Release 1.0.2

« Added support for Security Assertion Markup Language (SAML).
This feature enables Nomad users to authenticate through a SAML IdP rather than the Nomad
server. For information, see Configuring SAML authentication in the HCL SafeLinx documentation.
» Added support for Nomad federated login.
With Nomad federated login, users do not need to enter their Notes ID passwords during initial
configuration of Nomad for web browsers. They are presented with a login page from a SAML

IdP to authenticate and download their IDs from the ID Vault. For more information, see Nomad

federated login in the Domino documentation.

« Added support for panagenda MarvelClient Web Migration.

With panagenda MarvelClient Web Migration, a user's Workspace and Recent Applications can

automatically migrate to Nomad Web during the client's initial setup. For more information on


https://help.hcltechsw.com/nomad/1.0_admin/config_application_switcher.html
https://help.hcltechsw.com/nomad/1.0_admin/shared_usage_nomadweb.html
https://help.hcltechsw.com/dom_designer/12.0.0/basic/H_NOTESGPS_CLASS.html
https://help.hcltechsw.com/safelinx/1.4/adminguide/configuring_saml.html
https://help.hcltechsw.com/domino/12.0.0/admin/configuring_nomad_federated_login.html
https://help.hcltechsw.com/domino/12.0.0/admin/configuring_nomad_federated_login.html
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enabling this feature, see panagenda MarvelClient Web Migration in the Nomad Administration

documentation.

» Ul Improvements:
o Visual updates and improved keyboard usage in the top Navigation Bar.
o Visual updates to the Application Tab Bar.

Release 1.0.1

- Added support for the following languages: German, Spanish, French, Italian, Japanese, Korean,
Dutch, Polish, Portuguese, Russian, Swedish, Simplified Chinese, Traditional Chinese
« Added support for panagenda MarvelClient. panagenda MarvelClient allows administrators to

manage HCL Nomad clients by defining their own settings.

For more information, see HCL Nomad and panagenda MarvelClient in the Administrator
documentation.

« Added support for Nomad Federated Login.
Enabling Nomad Federated Login allows the end user to run HCL Nomad and perform secure

operations without being prompted for a Notes ID password. This requires an Identity Provider that
supports SAML (Security Assertion Markup Language).

Note:

Nomad Federated Login support is included but at a beta level, which means the feature

may be used to provide feedback but is not officially supported until a subsequent release.

For more information, see System requirements (on page 18).
- Support for additional key entry mechanisms to enter characters has been added.
In addition to the regular keyboard, alternate keyboards, Mac long press, Mac Option notation,

and Input Method Editors (IMEs) are now supported. Previously, certain characters could only be

entered via copy + paste.

« Support for rendering MIME type emails has been added.

Additionally, related actions (show images, load remote images, handle internet cross certificates)

are now supported.


https://help.hcltechsw.com/nomad/1.0_admin/marvel_web_migration.html
https://help.hcltechsw.com/nomad/1.0_admin/hcln_marvel_client.html

HCL Nomad for web browsers User Documentation | 1 - HCL Nomad for web browsers 1.0.x User
Documentation | 18

System requirements

Before you set up HCL Nomad for web browsers, check that your environment meets the following

requirements.

For the HCL Nomad for web browsers release notes, see this article.

» To use HCL Nomad for web browsers, you agree to obtain and maintain an active subscription
and Support for HCL Domino Complete Collaboration (CCB). Please note, only CCB customers are
entitled to use HCL Nomad for web browsers.
« An endpoint supporting WebSockets Secure traffic from the HCL Nomad clients. This endpoint can
either be Nomad server on Domino or HCL SafeLinx:
o If the endpoint is Nomad server on Domino:
= If not using Domino HTTP as an OIDC Provider, the Domino server running Nomad
server on Domino must be Domino 12.0.2 or higher.
= If using Domino HTTP as an OIDC Provider, the Domino server running Nomad server
on Domino must be Domino 14.0.0 FP2 or higher.
o If the endpoint is HCL SafeLinx:
= HCL SafeLinx 1.2.0 FP1 or higher is required.
= If you want to enable Nomad Federated Login, HCL SafeLinx 1.2.1 or higher is
required.
= HCL SafeLinx 1.3.0 or higher is recommended due to numerous fixes (including fixes
to file caching issues in older versions).
= A properly configured HCL Domino LDAP server and corresponding bind-user (Admin
ID) as documented in Configuring a Domino LDAP server for Nomad in the Nomad
Administrator documentation.
- Based on the endpoint selected, obtain the one zip file for your endpoint type from the My
HCLSoftware portal under package HCL_Nomad_Web_1.0x:
o If your endpoint is HCL Nomad server on Domino, you need the file with File ID HCL Nomad
Server <Version> for Donino <Domino Version> <Operating Systen> which will have File
Name nonad- ser ver - <Ver si on>- f or - doni no- <Doni no Ver si on>- <Cperating Systens. <file
ext ensi on>. This zip file contains both the Nomad server task files as well as the HCL
Nomad for web browsers client files in / nonad- f i | es. For more information on installing
Nomad server on Domino, see Installation in the Nomad Administrator documentation.
o If your endpoint is HCL SafeLinx, you need the file with File ID
HCL Nomad for web browsers <Version> which will have File Name
HCL_Nomad_web_<Ver si on>_<Bui | dDat eAndTi me>_f or _HCL_Saf eLi nx. <fil e extensi on>. This

zip file contains only the HCL Nomad for web browsers client files as the SafeLinx portions


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090289
https://support.hcltechsw.com/csm
https://help.hcltechsw.com/nomad/1.0_admin/prepare_domino_ldap_nomad.html
https://my.hcltechsw.com
https://my.hcltechsw.com
https://help.hcltechsw.com/nomad/1.0_admin/server_install.html
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are separate. For more information on installing HCL Nomad for web browsers on HCL
Safelinx, see Hosting the Nomad for web browsers static web files. For more information
on installing HCL SafeLinx, see Installing and setting up SafeLinx.

- Acquire a trusted TLS certificate to secure connections between Nomad and the endpoint that

Nomad is connecting to (Nomad server on Domino, SafeLinx or other proxy).

For more information on Nomad server on Domino, see Prerequisites and system requirements for
Domino in the Nomad Admin documentation. For more information on SafeLinx, see Completing

the prerequisites for SafeLinx in the Nomad Admin documentation.

« An HCL Domino® 12.x or 14.x ID vault containing at least the ID files of those users that need
to work via HCL Nomad for web browsers, as the ID files need to be downloaded from the vault

automatically.

Note:

If users want to utilize Domino HTTP as an OIDC Provider with HCL Nomad for web

browsers, the Domino server with the ID vault must be 14.0.0 FP2 or higher.

Tip: For end users to check whether your ID file is in a vault, from the Notes client, click File >
Security> User Security. You see the following text in the Security Basics tab when your ID is in a
vault: This ID file has been backed up into vault xxxx.Tip: Asa Domino Administrator, see

Viewing user IDs in a vault on how to verify the proper setup of the ID Vault.

« Domino® 9.0.1, 10.x, 11.x, 12.x, or 14.x servers containing your applications.

« A supported 64 bit (32 bit is not supported) desktop web browser. For each browser and release
channel, the official browser support is only for the current version of the browser and each new
browser version makes the previous browser version unsupported.

> Google Chrome Stable or Extended Stable release channels.
o Microsoft Edge Stable or Extended Stable release channels.
> Firefox Stable or Extended Support Release (ESR) release channels.

- Supported Languages - Catalan, Czech, Danish, German, English (Australia), English (UK), English,

Spanish, Finnish, French, Hungarian, ltalian, Norwegian Bokmal, Dutch, Polish, Portuguese, Russian,

Slovenian, Swedish, Thai, Turkish.

Using Nomad for web browsers

The following topics provide instructions on how to configure and use the browser for HCL Nomad for

web browsers.


https://help.hcltechsw.com/nomad/1.0_admin/hosting_static_files.html
https://help.hcltechsw.com/nomad/1.0_admin/setup_safelinx_nomad.html
https://help.hcltechsw.com/nomad/1.0_admin/prereq_requirements.html
https://help.hcltechsw.com/nomad/1.0_admin/nomad_complete_prereqs.html
https://help.hcltechsw.com/nomad/1.0_admin/nomad_complete_prereqs.html
https://help.hcltechsw.com/domino/12.0.0/admin/conf_viewinguseridsinavault_t.html
https://support.google.com/chrome/a/answer/9027636
https://learn.microsoft.com/en-us/deployedge/microsoft-edge-channels
https://www.mozilla.org/firefox/all/
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Browser configuration

This following topics provide information on how to set up Nomad for web browsers, which involves

configuring a supported browser on your system and running Nomad via a Nomad server on Domino or
SafeLinx URL.

Required browser configuration

Firefox

1.

Enter about:preferences#privacy in the address bar.

2. In the Cookies and Site Data section, uncheck Delete cookies and site data when

Firefox is closed OR add an exception for the server you are using (for example, https://

mysafelinxserver.mycompany.com).

. In the History section, either select Remember history or Use custom settings for history. If

you choose Use custom settings for history, ensure that Always use private browsing mode is
unchecked, Remember browsing and download history is checked, and Clear history when Firefox

closes is unchecked.

. If you changed any settings above, restart Firefox.

N

Note:
With some older versions of Firefox, running with the Web Developer Tools open may cause the
following message: TypeError: Mdul e. asmis undefi ned. If you encounter this error during

startup or in general, do not run with the Web Developer Tools open.

Chrome

1.

Enter chrome://settings/cookies in the address bar.

2. Turn off Clear cookies and site data when you close windows OR add an exception for the server

you are using (for example, mysafelinxserver.mycompany.com) to the Sites that can always use

cookies section.

3. If you changed any settings above, restart Chrome.

Microsoft Edge
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1. Enter edge://settings/content/cookies in the address bar.

2. Turn on Allow sites to save and read cookie data (recommended) OR add an exception for the
server you are using (for example, mysafelinxserver.mycompany.com) to the Allow section.

3. If you changed any settings above, restart Edge.

Granting Persistent Storage permission

HCL Nomad for web browsers stores files in the browser's local site storage. The browser has automatic
storage eviction logic that will delete this data if the local site storage gets too large. The files that Nomad
stores are generally small and unlikely to be evicted. However, with replication, the Nomad storage could
be very large and very likely to be evicted. To prevent this eviction, HCL Nomad needs the Persistent
Storage permission.

A Persistent Storage permission request is sent to the browser when the user selects a Domino
application and attempts to create a local replica (the “Make Available Offline” option). If the Persistent
Storage permission is not granted by the browser, a popup displays asking for the Notification permission.

The Notification permission is requested because Chromium-based browsers, Chrome and Edge, do not
show a prompt to the user to request the Persistent Storage permission. Persistent Storage permission
requests are handled automatically based on heuristic rules. Please refer to Chrome's documentation for
details. The Persistent Storage permission is automatically granted when the Notification permission is
granted.


https://chromestatus.com/feature/4931497563783168
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HCL Nomad

Motification permission is required to enable replication. If the notification permission
prompt is not openad automatically after clicking the OK button, go to the browsear's

site settings to allow notification permission

For more information, consult the product documentation

After clicking OK button, a Notification permission prompt should display to the user. If the Notification
permission prompt does not appear, the user can manually allow the Notification permission in the
browser’s settings. Please refer to Chrome's documentation for information on how to manually allow the

Notification permission.

An alternative way to allow the Persistent Storage permission is by creating a browser bookmark for HCL
Nomad. This only applies if the user has fewer than six bookmarks.

Another alternative way to allow Persistent Storage permission is by installing HCL Nomad as a
progressive web application (PWA) and launching HCL Nomad from the chr one: / / apps or edge: / / apps
page after the PWA is installed. Please refer to Google's documentation for information on how to install a
web application as a PWA.

Once HCL Nomad has the Persistent Storage permission, it will not be revoked (even if a user later
switches back to use HCL Nomad from a browser tab or if the user later denies the Notification
permission).


https://support.google.com/chrome/answer/3220216?hl=en&co=GENIE.Platform%3DDesktop
https://support.google.com/chrome/answer/9658361?hl=en&co=GENIE.Platform%3DDesktop
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Run Nomad

Follow the SafeLinx URL provided by your administrator - this should automatically configure the
application.

- ™
Note:
HCL Nomad cannot run in a "Private" Firefox window, as HCL Nomad requires service workers
which Firefox does not allow in a private window. You will get the following error: Normad
experienced an error during startup: Service worker is disabled or not supported by

this browser. dick Refresh to try again.

In Chrome/Edge, HCL Nomad runs in "Incognito/InPrivate" windows, however the data is deleted
when the tab is closed. In this case, you would be able to run HCL Nomad but would have to start
from scratch each time you run HCL Nomad.

o /

Optional browser configuration

Web + Notes protocol

In HCL Nomad, HTTPS URLs can be bookmarked (on page 26). However, a database or document

can also open in Nomad with its respective Notes link if the custom "web+notes" protocol is allowed

in the browser. To do this, copy a Notes link from the database or document properties in the fifth tab
under the Identifier field. Paste the link into the browser, and append web+ to the front of the link before
navigating to it. The link should now have the format: web+notes:/DB_IDENTIFIER/DOC_IDENTIFIER, or
web+Notes://DB_IDENTIFIER/DOC_IDENTIFIER. The custom protocol handler then instructs the browser
to navigate to HCL Nomad with a URL similar to https:/yournomaddomain.com/nomad/#/notes://
DB_IDENTIFIER/DOC_IDENTIFIER - the Notes link is provided as the hash property. For more information
on Notes links, see the HCL Notes documentation.

For the web+notes protocol to work, the protocol must be allowed by the user or by the browser

administrator. Allowing the protocol varies per browser and environment.

To check the the protocol configuration in the browser's settings, see the following links:

« Chrome: chrome://settings/handlers?search=protocols
- Edge: edge://settings/content/handlers?search=protocols
- Firefox: about:preferences#general and go to the Applications section.


https://yournomaddomain.com/nomad/#/notes://DB_IDENTIFIER/DOC_IDENTIFIER
https://yournomaddomain.com/nomad/#/notes://DB_IDENTIFIER/DOC_IDENTIFIER
https://help.hcltechsw.com/notes/12.0.0/client/sh_create_manage_links_c.html
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Google Chrome has a Chrome Enterprise policies feature, which can be used to manage custom

protocols like the web+notes protocol. For more information, see the following articles:

« Chrome Enterprise policy list

« RegisteredProtocolHandlers

Mozilla Firefox has a Policies feature, which can be used to manage custom protocols like the web+notes

protocol. For more information, see the Handlers - schemes policy in this article.

Notifications

HCL Nomad can use multiple windows and tabs to show content. There are also a number of scenarios
where HCL Nomad is already running in a tab and another tab is opened outside of HCL Nomad:

« If re-authentication is needed.
« If the user clicks on a URL to HCL Nomad from an external web page or application, whether it's an
HTTPS or web+notes link.

« If the user attempts to manually open Nomad in another tab.

The web browsers do not allow HCL Nomad to bring a window or tab into focus automatically, so if the
user has multiple tabs open, it may be difficult to find the correct HCL Nomad tab or window. To assist the
user in finding the correct HCL Nomad tab or window (if notifications are allowed), HCL Nomad attempts
to push a notification that (when clicked) brings focus to the correct window or tab.

For the notification to work, notifications must be allowed by the user or by the browser administrator.
Allowing notifications varies per browser and environment.

Google Chrome has a Chrome Enterprise policies feature, which can be used to manage notifications. For

more information, see the following articles:

« Chrome Enterprise policy list

» NotificationsAllowedForUrls

On MacOS, besides notifications being enabled for the site in Google Chrome, you must also enable the
notifications for "Google Chrome" and "Google Chrome Helper (Alerts)" in the Notifications section of the
MacOS Settings application.

Mozilla Firefox has a Policies feature, which can be used to manage notifications. For more information,
see the Permissions - Notifications policy in this article.


https://chromeenterprise.google/policies/
https://chromeenterprise.google/policies/#RegisteredProtocolHandlers
https://github.com/mozilla/policy-templates
https://chromeenterprise.google/policies/
https://chromeenterprise.google/policies/#NotificationsAllowedForUrls
https://github.com/mozilla/policy-templates
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Allow Popups

Beginning in release 1.0.8, Nomad for web browsers supports the Open in New Window feature. To use
this feature in Firefox, the Allow Popups option must be enabled.

Disabling Memory Saver

Starting in Chrome and Edge 108, a feature was added that can potentially cause data loss by discarding
tabs that have been unused in the background for some time. To prevent this, we recommend disabling
the feature for HCL Nomad for web browsers. To learn more about the Memory Saver feature in Chrome,

see this article.

To disable the feature for HCL Nomad for web browsers in Chrome, follow these steps:

1. Open Chrome and navigate to chrome://settings/performance
2. In the Always keep these sites active section, select Add.
3. Input HCL Nomad for web browsers' domain name in the "Add a site" prompt and click Add.

To disable the feature for HCL Nomad for web browsers in Edge, follow these steps:

1. Open Edge and navigate to edge://settings/system
2. In the Never put these sites to sleep section, select Add.
3. Input HCL Nomad for web browsers' domain name in the "Add a site" prompt and click Add.

Setting site permissions

Users can pre-allow or pre-block site permissions in their Chrome or Edge settings by navigating to either
of the following URLs:

Chrome: chrome://settings/content/siteDetails?site=https%3A%2F%2Fmynomadserver.com%2F
Edge: edge://settings/content/siteDetails?site=https%3A%2F %2Fmynomadserver.com%2F

Note:

Replace "mynomadserver.com" with your Nomad web address.

These permissions can be changed regardless of whether or not the end user has visited or setup Nomad
for web browsers at the given web address.

For example, a user can pre-allow the "Clipboard" permission for cut/copy/paste actions:


https://blog.google/products/chrome/new-chrome-features-to-save-battery-and-make-browsing-smoother/
chrome://settings/content/siteDetails?site=https%3A%2F%2Fmynomadserver.com%2F
edge://settings/content/siteDetails?site=https%3A%2F%2Fmynomadserver.com%2F
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File editing Ask (default)

HID devices Ask (default)

Ask (default)
Clipboard v Allow
Block

Payment handlers Allow (default)

(L ™
Note:
Firefox has clipboard access enabled by default (there is not an individual permission setting for
clipboard access), but Chrome and Edge have individual clipboard permissions which are blocked

by default.
- J

Bookmarks

When you open a database or document in HCL Nomad, the browser's URL is updated with a link to

the database or document. This URL can be bookmarked to revisit later. Bookmarks can be managed
as regular bookmarks in the browser, or shared with other users. However, if the other users are on a
different server, they may have to adjust the first part of the URL to their server, but the #/notes:// portion
should be the same.

Shared usage

You can preserve multiple users’ data when Nomad for web browsers is being accessed on a shared

computer.

Nomad for web browsers may be accessed on a shared computer in the following ways:

1. Recommended: Using different operating system logins. This would keep all user data separate at
the OS level including browser configuration and data.

2. Using different browsers. User data is isolated between the browsers but co-located on the same
0S login.

3. Using the same browser with different browser profiles. User data is isolated to the browser profile
but co-located on the same OS login.

4. Using the same browser with the same browser profile. There is no separation of user data so each
time the user is switched, the local data must be removed and the user must start fresh. Because
of the user having to start anew each time, this method is not recommended.
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(L ™
Note:
Only #1 keeps the data private from other users. The other methods allow for user data to be kept
separate, but the data is not protected against users that have access to the same OS login. It is

recommended to adhere to your organization's policies on OS access.
N /

Browser profiles
Nomad data will be isolated to the browser profiles, safely allowing multiple users to use Nomad.

Consult your browser’s support page for setting up profiles:

» Chrome: https://support.google.com/chrome/answer/2364824?hl=en

- Edge: https://support.microsoft.com/en-us/topic/sign-in-and-create-multiple-profiles-in-microsoft-
edge-df94e622-2061-49ae-ad1d-6f0e43ce6435

- Firefox: https://support.mozilla.org/en-US/kb/profile-manager-create-remove-switch-firefox-profiles

Using the same browser with the same browser profile

We recommend using different operating system logins (#1 from the list (on page 26)). However,
if separate operating system logins or browser profiles are unavailable, Nomad can be reset to allow

another user to login.

(L N
Note:
If separate operating system logins or browser profiles are unavailable, Nomad can be reset to
allow another user to login. Reset logs out and removes all Nomad data from the browser for the
previous user, including recent applications, and any local replicas the user may have created.

User data on Domino servers remains unaffected.
o J

There are three methods within Nomad to reset local Nomad data. One method is enforced by the
administrator via the resetNomadInstance=1 notes.ini; see Shared usage for additional instructions. The

other two methods involve the Nomad users:


https://support.google.com/chrome/answer/2364824?hl=en
https://support.microsoft.com/en-us/topic/sign-in-and-create-multiple-profiles-in-microsoft-edge-df94e622-2061-49ae-ad1d-6f0e43ce6435
https://support.microsoft.com/en-us/topic/sign-in-and-create-multiple-profiles-in-microsoft-edge-df94e622-2061-49ae-ad1d-6f0e43ce6435
https://support.mozilla.org/en-US/kb/profile-manager-create-remove-switch-firefox-profiles
https://help.hcltechsw.com/nomad/1.0_admin/shared_usage_nomadweb.html
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« In an existing Nomad session, the logged-in user can click Reset Nomad under the profile menu in
the top-right corner.

Log out

Reset Nomad

In the Reset Nomad dialog that displays, click Reset Nomad to confirm the action. The user will
then be presented with the login page after resetting Nomad.

» When a new user is logging into Nomad, if the previous user’s local data had not been cleared, the
following dialog displays:
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\
HCL Nomad

This instance of HCL Nomad was not configured for
User1 Nemad/pnphcl. If you continue as User1
Nomad/pnphcl, the original user's local data will be
deleted. To use multiple accounts, use separate
browser profiles.

Log in with original credentials

‘ Continue as User! Nomad/pnphcl ‘

Click Log in with original credentials to logout and log back in as the original user. This should only
be necessary when the logout was not done previously or you have multiple users' credentials and
logged in as the wrong user.

Click Continue as <user> to reset the original user's data and continue setting up Nomad as
<user>. For security reasons, we never reveal the original user's name.

Notes links

Nomad handling of not es: / / links

Notes links (links using the not es: / / protocol) can now be handled by Nomad if you register
Nomad to be the protocol handler in the operating system. To assist in this enablement,
Nomad includes instructions and relevant files in a sub-directory. For more information, see
htt ps:// <mynonadser ver >/ nomad/ not esl i nk/ r eadne. ht ml (for example, ht t ps: //

nynomadser ver . myconpany. com’ nomad/ not esl i nk/ readme. ht nl ).
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Opening Nomad links in existing app window

When opening Nomad links from your web browser, the installed Nomad application will open if the

navigation is performed in one of the following ways:

« Clicking on an anchor with t ar get =" _bl ank" set: <a href="https://
your nonmadser ver. coni nonad/ #/ notes: //1inktodb" target="_bl ank"
rel ="noopener">Li nk to DB</a>

« A click handler calls wi ndow. open( your NormadLi nk, " _bl ank", "noopener");

Both of these methods allow the browser to open the PWA app window directly. You may also use web
+not es:// |inks, assuming users have accepted the permission to use the web+notes custom

protocol (see Web + Notes protocol (on page 23) for more information).
Replication

Creating local replicas

1. Open the application.

2. Select File > Application > Make Available Offline OR from the Workspace right-click on the icon
and select Application > Make Available Offline.

3. Complete the following fields and click OK.

Option Description
File path File name with optional path for the replica.
How much data do you want to receive? > Select All documents to replicate all doc-

uments. Or, select Documents that meet
a selection formula and input a formula
to select the documents to replicate.

> To prevent large attachments from repli-
cating, select Limit attachment size and
enter a size limit. Documents with at-
tachments larger than the limit are repli-
cated without the attachments.

Do you want to remove documents To remove older unchanged documents from

from the replica to save space? the local replica, select Remove documents not
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Option Description

modified in the last XX days. Enter the number
of days after which unchanged documents are

deleted to save space.

To open the local replica, select Open > Open Application, and open the nsf from Local.

You can also open the replica from the Workspace icon (stacked or unstacked).

Managing local replicas

1. To open the Replication page, select select Open > Replication.
A list of your local replicas is shown that includes the last replication time and replication summary
for each one.

2. Choose an action:
o To replicate all local replicas, select Replicate All.
o To replicate one local replica, control-click and select Replicate Selected Application.

> To delete a local replica, control-click and select Remove.

Offline mode

Offline mode allows users to continue working in local replicas without interruption if the connection is

lost. This includes utilizing a local mail.box for sending mail while offline.

Note:

Online connectivity is required when setting up Nomad for the first time, or after clearing the

browser data to reset Nomad.

If your browser supports replication (for more information, see System requirements (on page 18)),
an indicator in the status bar provides connection status and information about the last replication run.
Opening the indicator also refreshes the status.
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Last replication/sync ran
at 11:31 AM Today,
scheduled
replication/sync is
disabled

If the user loses network connection, the indicator reads offline with a message stating No i nt er net

connecti on.

No Internet connection.
Last replication/sync ran
at 11:31 AM Today,
scheduled
replication/sync is
disabled

If the Nomad server cannot be reached or is experiencing issues, the indicator reads offline with a

message stating Nonad servers can’'t be reached.
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Nomad servers can't be
reached. Last
replication/sync ran at
11:31 AM Today,
scheduled
replication/sync is
disabled

If a user's authentication expires, they will only be prompted to login if they are online.

If the user is already offline before opening Nomad, they are able to start Nomad and work with offline

replicas without being prompted to log in.

Restyle

Domino Restyle updates an application's Ul elements with a color-coordinated, cleaner look and feel. With

Restyle, only Ul elements are updated; no code is modified.

To access the Restyle option, select File > Application > Restyle for a selected application or workspace

icon. Designer access to the application is required to use Restyle.
For more information, see Domino Restyle for Notes applications in the Notes documentation.

Note:

Restyle is available initially only in English; therefore, the browser language must be set to English

for Restyle to appear.

The following sections describe Restyle features available with Nomad for web browsers:


https://help.hcltechsw.com/notes/12.0.2/client/restyle_applications.html
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Launch property features

If your application does not launch to a frameset, on the Launch property tab in the Restyle dialog you can
choose to include the necessary components for the application to launch to a frameset. The frameset
includes an application name area, an outline area, a server location area, and a content area. These
components are copied in from a template shipped with the product, and then customized for your

application by the restyle process.
Restyle: newdb - newdb.nsf

This application does not have the launch property set to a frameset.
1 Select theme
Would you like us to update your launch property to a standardized frameset?
o Launch property Y pasay PP
The frameset includes: Application name, Outline, Server Name, and View.
® Yes (recommended)

O Ne

3 Confirm settings

4 Create icon

Cancel Previous [|

Next —

If your application does launch to a frameset, but not all of the frames have mapping assignments, the
Confirm mapping tab is still shown, but there is an additional option to allow you to update the launch
property. Nothing is removed from your application if you choose this option, but the new components are
copied from the template, and the application's launch property is updated to match the new design.
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Restyle: katie - katie.nsf

Restyle: katie - katie.nsf

Confirm mapping of pages or forms so that they may be styled appropriately. If your application does not

1 Select theme have pages that match this description, select not applicable.

€ confirm mapping Application title

3 Confirm settings Define the page or form that includes the name of the application.

Named element Title
4 Create icon Form v Mot applicable v
Outline

Define the page or form that provides the end users with a way to navigate the application,

Named alemant Title
Form - Mot applicable v
Server name

Define the page or form that includes the name of the server. Sometimes this is included with the
Application title. In that case, select not applicable.

MNamed element Title

Form v Not applicable v

Convert to standardized frameset

One or more of the expected frames cannot be mapped. Would you like to use a standardized
frameset with Application Name, Outline, Server Mame, and View?

() Yes (recommended)

@No

| Cancel I Previous

If your application launches to a frameset, and all the frames have been mapped, the option to convert to
a standardized frameset is not shown.

Defining application colors with Restyle

Restyle provides a set of coordinated colors and the ability to choose a custom color for each individual
application being restyled. However, there may be instances where an installation's own corporate colors
do not align with the predefined set. In such cases, Restyle allows for the creation of a customization
database which extends the standard application colors to all users of the installation.

For more information, see Restyle Configuration Store (on page 46).

Follow the steps in the sections below to define your own application colors for use when restyling
applications with the Restyle feature.
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Prerequisites

« HCL Domino Designer installed on your machine.
« A basic understanding of JSON (JavaScript Object Notation) format.
» A JSON-compatible editor.

« Alocal replica of rest yl e. nsf. See Restyle Configuration Store (on page 46).

Create the File Resource

Use HCL Domino Designer to create a file named app_col or/ col ors. j son under Resources > Files.

1. In the Domino Designer workspace, open the rest yl e. nsf database.

2. In the left pane of the database design, expand Resources and click Files.
3. Click New File Resource.

4. In the File Name field, enter app_col or/ col ors. j son.

Add color descriptions

It is recommended that you use an editor that supports JSON syntax checking to create a file and then

copy that file via the clipboard into HCL Domino Designer.

Create a text file named col or s. j son and structure the content as follows with one or more color
descriptions:

{

"version": "1.0.0",

"My Green": {

"description": "My green color.",
"app.primry.color": "#3CB371",
"app. secondary. col or": "#FFDEOO"

Here's a breakdown of each field:

"version": This specifies the version of your color configuration file. It needs to be 1.0.0 for the
current version of Nomad for web browsers.

"My Green": This is an example color name. You can choose any name, in any language. However, it
is recommended to name them something other than the existing restyle colors.

"description": A brief explanation of the color. This is an optional field.
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- "app.primary.color": This is the primary color for your application, specified in HEX color code.

- "app.secondary.color": This is the secondary color for your application, specified in HEX color code.
It's rarely used in the existing restyle themes but is required. It can be defined the same as the
“app.primary.color'.

Copy, Save and Close the File Resource

After filling in your desired colors, copy the file back to the File Resource named app_col or/

col ors. j sonin HCL Domino Designer.

1. Select the entire file and copy to the clipboard.

2. Openthe app_col or/ col ors. j son file resource in HCL Domino Designer and paste the file
contents into the editor.

3. Click File > Save.

4. Click File > Exit.

Verify your changes are available

1. Ensure your local replica of rest yl e. nsf has replicated to the server copy.
2. Using Nomad for web browsers, select a database template to restyle.

3. Click File > Application > Restyle to display the restyle options.

4. Your custom color should appear in the list of application colors.

Customizing themes with Restyle
Restyle can utilize user-supplied themes.

These themes are stored in Restyle Configuration Store (on page 46).

Restyle Themes

A Restyle theme is a JSON-formatted document containing configuration elements that control how
Restyle updates the design elements of a Notes database. A JSON schema, describing the structure of a
Restyle theme, is used to validate a theme document before Restyle uses it.

Prerequisites

1. HCL Domino Designer installed on your machine.
2. Understand the JSON (JavaScript Object Notation) format at a basic level.
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3.
4.

A JSON-compatible editor.
A local replica of rest yl e. nsf . For more information, see Restyle Configuration Store (on page
46).

Exporting Themes from Restyle.nsf

The best way to create a custom theme is to start with an existing theme and modify it as needed. Export

a theme and the theme schema from r est yl e. nsf by following these steps:

N oo g b~ 0N =

. Create a directory to use as a destination for the theme and schema files.

. Launch Domino Designer.

. Open the local replica of r est yl e. nsf.

. Navigate to Resour ces/ Fi | es and double-click the Files entry.

. Select reserved/ schema/ t hene- <ver si on>. j son and click Export. This is the "theme schema".
. Select the directory created in step 1 and click Save to save the schema file.

. Select any document under r eser ved/ t hene to use as a starting theme and click "Export".

Note:
The file names contain the sequence 2f instead of the '/". Since you are not importing these files

after changing, you can rename to remove the 2f if desired.

Creating a Customized Theme

There are two options possible when creating a new theme file. The first is to create a complete copy

and modify all parameters, the second is to include an existing complete theme and override specific

properties in the customized theme definition.

Creating a complete copy

1.

2.

3.

With your JSON-capable editor, open the exported theme file and save as a new theme file, for
example: my_cust om t hene. j son.

For best results, configure your editor to associate the theme schema with your new theme. This
provides auto-complete functionality and validates the document before Restyle uses it.

Modify the theme document as needed.

Overriding an existing configuration
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1. With your JSON-capable editor, open the exported theme file and "save as" a new theme file, for
example: ny_cust om t hene. j son.

2. Add the following property to the top level of the document: "i ncl ude” : "<t heme_nane>"

3. Any properties defined in this file will override properties with the same name from the included
file. Here is an example that overrides properties of the colorful_action_bar theme:

{
"version": "1.0.0",
“include": "colorful _action_bar",
"el ements": {
"actionBar": {
"size": {
“height": {
"units": "Exs",
"val ue": 4.75
h
"font": {

"typography": "Body 2"

b
“background”: {
“color": {

"$ref": "#/ palette/ app.prinmary.color”

e
“border": {
“dropShadow': true,
" dr opShadoww dt h": 55,
"t hi ckness": {
"bottont: 1,
"left": 2,
“right": 3,
“top": 4
h
"inner": {
"bottont: 5,
"left": 6,

“right": 7,
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“top": 8

b

“outer": {
"bottont: 9,
“left": 10,
“right": 11,
"top": 12

b

“color": {

"$ref": "#/ pal ette/ background.light.primry"
I
“line": "Solid"
b
“button": {
“heightStyle": "Default",
"hei ght Absol ute": 24,
“w dt hStyle": "Absolute",
“w dt hAbsol ute": 145,
“margin": 24,
“di spl ayBorder": "Never",
“internal Margi ns": 16,
"backgroundCol or": {
"$ref": "#/ pal ette/ app.prinmary.color"
H
“font": {
“typography": "Button",
“color": {

"$ref": "#/ pal ettel/text.darkbg. secondary"
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Verify your changes are available

1. Ensure your local replica of r est yl e. nsf has replicated to the server copy.
2. Using Nomad for web browsers, select a database template to restyle.
3. Click File > Application > Restyle to display the restyle options.

4. Your custom theme should appear in a dropdown under the built-in theme choices.

Customizing theme colors with Restyle

Restyle can utilize user-supplied theme color configurations.

These configurations, known as palette definitions internally, are stored in the Restyle Configuration Store
(on page 46).

Understanding Restyle Palette Definitions

Restyle palette definitions are JSON documents that define the color scheme used by a theme. The
palette definition also contains an optional "mapping" section that controls how Restyle calculates color
mapping values based on the hue of an existing color in an application.

Prerequisites

1. HCL Domino Designer installed on your machine.

2. Understand the JSON (JavaScript Object Notation) format at a basic level.

3. A JSON-compatible editor.

4. Alocal replica of rest yl e. nsf. For more information, see Restyle Configuration Store (on page
46).

Exporting Themes from Restyle.nsf

The best way to create a custom palette file is to start with one of the HCL-supplied palette files and
modify it as needed. The following steps describe the process:

1. Create a directory to use as a destination for the theme and schema files.
2. Launch Domino Designer.

3. Open the local replica of r est yl e. nsf .

4. Navigate to Resour ces/ Fi | es and double-click the Files entry.

5. Select reserved/ schens/ pal et t e- <ver si on>. j son and click Export. This is the "palette schema".
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6. Select the directory created in step 1 and click Save to save the schema file.
7. Select any document under r eser ved/ pal et t e/ <nane>. j son to use as a starting palette and
click "Export".

Note:

The file names contain the sequence 2f instead of the '/'. You can rename the files to remove 2f if

you wish, as these files won't be imported after modification.

Creating a Custom Palette

There are two options possible when creating a new palette file. The first is to create a complete copy
and modify all parameters, the second is to include an existing complete palette and override specific
properties in the customized palette definition.

Creating a complete copy

1. With your JSON-capable editor, open the exported palette file and save as a new palette file, for
example: my _custom pal ette.json.

2. For best results, configure your editor to associate the palette schema with your new palette. This
provides auto-complete functionality and validates the document before Restyle uses it.

3. Modify the palette document as needed.

Overriding an existing configuration

1. With your JSON-capable editor, open the exported palette file and "save as" a new palette file, for
example: my_cust om pal ette. j son.

2. Remove the "Sschema" property found at the top of the document.

3. Add the following property to the top level of the document: "i ncl ude" : "<pal ette_name>"

4. Any properties defined in this file will override properties with the same name from the included
file.

(L ™
Note:
The "standard" property is required, but the "mapping" property is not. Here is an example
that overrides a few of the background properties of the creamy_taupe palette:

{
“nane": "partial _palette",
“version": "1.0.0",

“include": "creany_taupe",
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"standard": {
/

“background. paper*: "#FFF",

“background. | ight.primary": "#F7FAFF",
"background. | i ght. secondary": "#F2E8F0",
"background. border": "#CAFODF",
"background. dark. pri nary": "#0F253C",
"background. dar k. secondary": "#273F61",

“background. outline": "#FDF7FD"

- J

Saving Results to Configuration

To import the new palette document into rest yl e. nsf:

. Launch Domino Designer.
. Open the local replica of rest yl e. nsf.

1
2
3. Navigate to Resour ces/ Fi | es and double-click the Files entry.
4. At the top of the "Files" collection, click New File Resource.
5

. Enter pal ett e/ my_cust om pal et t e. j son (or whatever you named your palette file) as the name.

Note:

The "palette/" prefix is required to allow the Restyle feature to find the custom palette.

. Enter a user-friendly display name as the alias value.
. Comment is not currently used but may be useful for documentation purposes.
. In your JSON editor, select the entire document and copy to the clipboard.

O 00 N o

. Paste the contents of the clipboard into the newly created file resource in Domino Designer.

Using the Customized Palette

Whenever you launch the Restyle wizard, you will now see your custom palette listed in the "Theme Color'

drop down.

Customizing typography with Restyle

Restyle can utilize user-supplied typography stored in the Restyle Configuration Store (on page 46).
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Restyle typography

Restyle typography is a JSON-formatted configuration document containing typography definitions used
by themes. Typography definitions are named JSON elements that consist of a typeface name, font size

and style array.

Note:
Typography customization requires the use of a user-supplied theme. See Customizing themes
with Restyle (on page 37).

Prerequisites

1. HCL Domino Designer installed on your machine.

2. Understand the JSON (JavaScript Object Notation) format at a basic level.
3. A JSON-compatible editor.

4. Alocal replica of rest yl e. nsf. See Restyle Configuration Store (on page 46).

Exporting typography configuration from Restyle.nsf

The best way to create a custom typography file is to start with the default typography file and modify it
as needed. Export the default typography file and the typography schema from restyl e. nsf by following
these steps:

Create a directory to use as a destination for the typography and schema files.
Launch Domino Designer.

1.

2.

3. Open the local replica of rest yl e. nsf .

4. Navigate to Resources/Files and double-click the Files entry.
5.

Select reser ved/ schema/ t ypogr aphy- <ver si on>. j son and click Export. This is the "typography

schema".

o

. Select the directory created in step 1 and click Save to save the schema file.
7. Select reser ved/ t ypogr aphy/ def aul t - t ypogr aphy. j son to use as a starting theme and click Export.

Note:
The file names contain the sequence 2f instead of the ' /' . Since you aren't importing these files
after changing, you can rename to remove the 2f if desired.
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Creating a custom typography

1. With your JSON-capable editor, open the exported typography file and save as a new typography
file, for example: ny_cust om t ypogr aphy. j son.

2. For best results, configure your editor to associate the typography schema with your new
typography. This provides auto-complete functionality and validates the document before Restyle
uses it.

3. Modify the typography document as needed.

4. Import the new typography document intorestyl e. nsf:

a. Launch Domino Designer.

b. Open the local replica of rest yl e. nsf .

c. Navigate to Resour ces/ Fi | es and double-click the Files entry.

d. At the top of the "Files" collection, click New File Resource.

e. Enter t ypogr aphy/ ny_cust om t ypogr aphy. j son (or whatever you named your typography file)

as the name.

Note:

The "t ypogr aphy/ " prefix is required to allow the Restyle feature to find the custom

theme.

f. Enter a user-friendly display name as the alias value.

g. Comment is not currently used but may be useful for documentation purposes.

h. In your JSON editor, select the entire document and copy to the clipboard.

i. Paste the contents of the clipboard into the newly created file resource in Domino Designer.
5. Update your custom themes to use the new typography configuration:

a. Open a custom theme.

b. At the top of the theme, add a property named "typographyOverride" with the value of your

new typography configuration. For example:

{

"version" : "1.0.0",

"typographyOverride" : "my_customtypography”,

c. Save the theme.
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Using the customized typography

Whenever a user applies a theme that references the custom typography file, the new typography settings

will override the default settings in the theme.

Note:

It is necessary to define all of the typography definitions referenced by the theme.

Restyle Configuration Store

Restyle can utilize customized configuration stored in an instance of a database named r est yl e. nsf.

A common use of this feature involves creating a server-based instance of restyle.nsf from the local
restyl e. ntf template, followed by creating a local replica of restyle.nsf to be used by the client running

Restyle.

Create the Customization Database

To enable this feature, you need to create a database named "restyle.nsf" from the restyl e. nt f advanced

template, which is included with Nomad for web browsers

1. From the main menu, navigate to File > Application > New.
2. In the section titled "Specify New Application Name and Location":
a. Select a server that allows you to create a database.
b. Enter a descriptive title for the database.
c. Specify restyl e. nsf as the filename.
3. In the section titled "Specify Template for New Application":
a. Select Local as the server name.
b. Select the Show advanced templates checkbox. This option allows advanced templates to
be displayed in the selection.
c. In the "Template" section, select "restyle.ntf" from the dropdown list.
d. Ensure the Inherit future design changes checkbox is selected. This ensures the new
database will receive future design updates.
4. Click OK to create the new database.
5. When asked, "Do you want to index this database now?", select No.

6. Close your application.
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Create a Local Replica of the Customization Database

For Nomad for web browsers to use the custom configuration store, you need to create a local replica of

the "restyle.nsf" database.

1. Launch Nomad for web browsers.

2. Open the shared copy of r est yl e. nsf that was created in the previous steps.
3. Click on the Home tab, then select Launch Workspace.

4. Right-click on the application and select Application > Make Available Offline.
5.
6
7
8

Confirm that the file name is "restyle.nsf".

. Select All Documents and leave the other settings as they are.
. Ensure that the Remove documents not modified... checkbox is not ticked.

. Click OK. You will see the replication page indicating the replication progress.

Note:
If you update the contents of the server replica of r est yl e. nsf, these changes will appear in
Nomad for web browsers when replication occurs.

Making a copy of an application in Restyle

Restyle now offers the option to make a copy of an application to restyle, rather than needing to restyle

the original application.

You may still choose to restyle the original application, but it is not the default. If you choose to make

a copy, Restyle will create a design-only copy of the application (no data documents are copied), and

its file name is prefixed with r s_. Only one copy of the application is made; if you restyle a copy of the

application, you are not prompted to make another copy.

The following dialog appears when you select File > Application > Restyle:
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Restyle Confirmation

Restyle will change the design of this application ar template, itis recommended to make a backup. Wauld
yol like to restyle a copy of the design instead? No data will be copied.

@® Make a copy, 5o that | can test styles for this application.
{3 Restyle this application, | know the changes | would like to make.

2 Make a new copy, so that | can test restyle from scratch.

In 1.0.11, if you want to restart the restyle process on a fresh copy, a new option is available in the dialog
to allow you to start from a new copy. You may select this option if you attempt to restyle the application
and a copy already exists. Subsequent restyles would use the settings from that copy as the basis for

restyle of the application.

Updating icons with Restyle

Restyle now provides updated action and view icons.

For more information on the Update standard action and view icons setting, see Domino Restyle for

Notes applications in the Notes documentation.

Action icons

When you restyle an application, if you have selected Update standard action and view icons, actions that
use standard Notes action icons will instead use a new set of updated icons. The meanings of the icons
have been mapped, such that the icon chosen pre-Restyle retains the same meaning after Restyle.

= v v A :
< Mail X delete {p)House Q search seven chart  §f vip

Restyled action icons may be selected for applications that are not restyled. Previously, restyled
applications received updated action icons. Beginning with this release, these icons are available to
applications whether or not they have been restyled (Action Bar > Button Properties > Use restyled

icons).


https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html
https://help.hcltechsw.com/notes/14.0.0/client/restyle_applications.html
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When Use restyled icons is selected for an action bar, when you choose "Notes" for an icon type for an
action, the updated icons displayed in the following graphic are available as options. Each icon is an
updated version of the corresponding icon available if Use restyled icons is not checked.
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View icons

Restyle changes the selection indicator in views if the restyle setting Update standard action and view

icons is selected.

Rather than the familiar checkmark, selection is now shown with checkboxes - indicating both the
selected and unselected states. If the restyle setting is not selected, the selection indicator is not

updated.

The following image displays the selection indicator when Update standard action and view icons is

selected:
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New Main Topic

12/04/2023
12/04/2023
12/04/2023
12/04/2023
12/04/2023
® 12/04/2023

This feature is also available as a View property (style tab) in Designer, so it can be selected even for
applications that have not been restyled, or unselected after restyle if it is not what is needed.

Select Use checkboxes for selection to apply the selection updates.

If the application has been restyled, the checkboxes will be the application color; otherwise, the
checkboxes will be blue.
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Custom Application Builder

The custom application builder in Nomad for web browsers provides the ability to create a new
application with fundamental components such as a view, form, and action bars created automatically.
Users can provide a brief description of the data elements that an application needs to manage.
Alternatively, a user can generate an application based on a comma-separated value (CSV) formatted file

and optionally import data from that file into the new application.

Creating a Custom Application

To create a new custom application:

1. Launch Nomad for web browsers.
2. In the main menu, navigate to File > Application > New.
3. In the section titled Specify New Application Name and Location:
a. Select a server that allows you to create a database.
b. Enter a descriptive title for the database.
c. Enter a descriptive filename for the database.
4. In the section titled Specify Template for New Application:
a. Select Local.
b. Select Create Custom.
c. Click OK to launch the Customize New Application wizard. The following image shows the

"New Application" dialog as described in the steps above:
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New Application

Specify New Application Name and Location

Server Local
Title | Custom Application
File name | custom.nsf

Specify Template for New Application

Server Local

(B -Blank-

[E Create Custom
Template 8 Design Synopsis

8 Personal Address Book
File name |

[] Show advanced templates

(] Inherit future design changes

Cancel

Advanced...

About...

Selecting a Theme

In the Select Theme pane:

1. Select the "Import" button to use restyle settings from a previously restyled database.

2. Click "Next" to move to the "Define Data" pane.

Alternatively:
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1. Select a theme color.
2. Select an application color.
3. Select a layout.

4. Click Next to move to the Define Data pane.

The following graphic shows the Select Theme pane:

Customize New Application: Custom Application - custom.nsf

0 Import restyle settings from another application

Theme color Application color
2 Define Data

‘ Neutral Gray v | ‘ Blue v |
3 Createicon

@® Colorful action bar O Simple

O Dark outline O Dark colorful action bar

Defining Data

There are two options for defining data. The first is to describe each field manually providing a display
label, programmatic field name and data type. The second is to import the field description and optionally
import data from a comma-separated value (CSV) formatted file.

To describe each field manually on the "Define Data" panel:
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« Select the Define Your Data button.
« Enter a form and a view name.

- Add fields that capture the values your application needs.

Defining Fields

Each field is described with a set of properties as described here:

- Field label - The human-readable name that describes the field.
- Field name - The programmatic name used by the application code to reference the field. The
following characters are prohibited: <space>$#%&* {}\: <>2/ +| "* ,\ -
* Field type:
. o Text - Text stored with no formatting.
o Integer - Notes number limited to positive and negative integers.
- Decimal - Notes number limited to fixed-point decimal values.

o Currency - Notes number limited to currency values. Values are formatted as currency using

the locale indicated by the local operating system.

o Scientific - Notes number displayed with scientific notation.

o Date - Notes time-date value formatted with the date display preferences indicated by the
local operating system.

> Time - Notes time-date value formatted with the time display preferences indicated by the
local operating system.

o Date & Time - Notes time-date value formatted with both time and date preferences
indicated by the local operating system.

» Rich Text - Notes rich text value with advanced formatting capabilities including image
display.

- Sortable - Check this box if the value should be represented in the view with a sortable column.

Note:

You must select this when adding the field. It cannot be changed once the field is added.

« Click the Add button to add the field to the application. The Move Up and Move Down buttons allow

fields to be re-ordered. The top-down ordering shown in the wizard will be the top-down ordering in
the generated form and the left-to-right ordering in the generated view.
« Click the Remove button to remove any field definitions not needed.

The following graphic shows the wizard about to create a new application with a form named "Expense”, a

view named "Expenses’, and a single text field named "Employee":
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Customize New Application: custom - custom.nsf

Define Data
1 Select theme

@® Define your data O Import spreadsheet
o Define Data
Form name: View name:

3 Createicon | Expense | | Expenses

Add Fields

Field label: Field name:

Field type:

‘ Text v ’

[ Sortable

Tt Employee

Remove

o) [ reee )

Importing CSV

Importing a CSV file will produce an application with fields that correspond to the columns in the CSV.
The datatype of each column will be determined by the corresponding value in the second row. Cells in a
row that extend past the rightmost cell in the first row will be ignored. The character encoding of the CSV
file is assumed to be UTF-8. The data import process runs in the background so that large files can be
consumed while continuing to use Nomad for web browsers for other tasks.

Creating an Icon

Select the default app icon, use the icon builder to create your own or import an icon image from the file
system. Click OK to create the application.
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Importing Restyle settings
Restyle settings from a previously restyled database can be reused with the Import action on the Themes

panel of the restyle wizard.

To import settings:

1. Click the Import button.
2. Select a database that has been restyled. The restyle wizard will now be populated with settings
from the selected database. Settings that are only applicable to a specific application, such as

forms mapping, are not copied.

Designer

You can use HCL Nomad for web browsers to design Notes databases.

Nomad Designer will open in a separate browser window from HCL Nomad. To open Nomad Designer:

- Select Open in Designer from the workspace icon of a database to which you have design access.

- Select Open in Designer from the tab of an open database.

- Utilize the following Notes URL as a web browser bookmark for Nomad for web browsers including
the URL, the Application Switcher, or the StartupURL notes.ini:

notes:///C i ent Bookmar k?QpenDesi gner

Access to Nomad Designer is enabled by default, but is only available when the user has the appropriate
access to the database. To explicitly disable access to Nomad Designer, choose one of the following

options:

- Set the notes.ini mentioned in Setting notes.ini values in the Nomad Administrator documentation.
« Use the MarvelClient Application Restriction. For more information, see Configuring application

restrictions on Nomad for web browsers in the Nomad Administrator documentation.
For more information, see the Designer limitations (on page 77).

Designer Preview
When you use preview in Nomad Designer as documented in Previewing your design work.

There is an additional header to allow you to visualize a design element in various screen sizes. On the left
is the name of the design element, in the center is a pulldown selector for platforms, and on the right is a

button to close the current design element and return to Designer.


https://help.hcltechsw.com/nomad/1.0_admin/nomad_set_notesini.html
https://help.hcltechsw.com/nomad/1.0_admin/configure_app_restrictions_web.html
https://help.hcltechsw.com/nomad/1.0_admin/configure_app_restrictions_web.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_ABOUT_PREVIEWING_YOUR_WEB_DESIGN_WORK.html
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The pulldown selector for platforms in the center allows you to select between Phone, Tablet, and
Desktop. When the selection changes, the size of the design element will immediately change. When the
size changes, the Formula elements are evaluated such that formulas like @Platform, @ResolutionWidth
<linked to ???>, @ResolutionHeight <linked to ???> can be used to adjust the layout of the element. If the
platform differentiates between landscape and portrait modes, there will be an additional button to the

right of the pulldown selector for platforms to toggle between landscape and portrait modes.
Customizing the platform choices:

The list of choices in the pulldown can be modified by creating a local designPreview.nsf and specifying

additional choices in there:

1. Select File > Application > New

2. Leave Server as local, In File Name, enter “designPreview.nsf” (it must be this name)
3. Check “Show Advanced Templates”

4. Select the “Design Preview customization” template

5. Click Ok (the new application will open).

6. Modify the records in the database as you wish to change the pulldown list. You can duplicate the

existing elements with copy/paste to make it easier to customize.

Designer Formula @Functions

Following @Functions are available in Nomad for web browsers Designer.

@ScanBarcode (Formula Language)
Returns a scanned barcode.

If using HCL Nomad for iOS or Android, then @ScanBarcode will invoke the device’s camera and allow the

user to use their mobile device to scan a barcode.

Note:

If used on platforms other than Nomad Mobile, @ScanBarcode will return an empty text string.

Syntax

@ScanBarcode


https://help.hcl-software.com/dom_designer/14.0.0/basic/dql_formulalanguage.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_PLATFORM_FUNCTION.html
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Return value
barcode Text

The barcode scanned by the user using the device camera. This value is empty if the user denies Nomad
permission to use the device camera. This value is also empty if the user cancels the barcode scanning

process before a barcode is scanned.

Related information

Domino Designer @ScanBarcode (Formula Language)

File Storage

Due to browser restrictions, Nomad for web browsers does not have access to the native operating
system’s file system and instead uses the Origin Private File System (OPFS) to store files needed for
ordinary operation. The OPFS is contained within the browser’s sandbox for the site and is not accessible
from other sites nor the native operating system. Because the OPFS is in the browser storage, clearing the

browser storage also clears the file system.

Not having access to the native operating system’s file system and instead using the OPFS introduces
some unique behaviors in LotusScript functions that are intended to reference the native operating
system. The prefix vfs: (for Virtual File System) is used to specify that the file is in the OPFS in the
following functions.

LotusScript Special behavior

functions
If the vfs: prefix is used in the file name, the file is placed in the OPFS and can be ac-
NotesEm-
oresEm cessed using other LotusScript functions. If the file name specified does not begin with
beddedOb- L . . ,
vfs:, this will cause the extracted file to be downloaded to the native operating system'’s
ject.Extract- . .
file system using the browsers download function.
File
FileExport
@Command
(Formula
Language)
You must specify vfs: prefix in the file name to access a file in the OPFS because you can-
Notes-

not directly access files in the native operating system'’s file system from a web applica-
RichText-


https://help.hcl-software.com/dom_designer/14.0.0/basic/H_Scanbarcode.html
https://developer.mozilla.org/en-US/docs/Web/API/File_System_API/Origin_private_file_system
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EXTRACTFILE_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EXTRACTFILE_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EXTRACTFILE_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EXTRACTFILE_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_FILEEXPORT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_FILEEXPORT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_FILEEXPORT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_FILEEXPORT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EMBEDOBJECT_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EMBEDOBJECT_METHOD.html
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ltem.Embed- tion. If the file name specified does not begin with vfs:, the operation will fail with File not
Object found.

Notes-

Stream.Open

Open state-

ment

When using the HCL Nomad for web browsers COM Helper (on page 61) extension, the native
applications that are invoked by COM operations only have access to the native operating system, so
they cannot access the OPFS. In order to help with this problem, there are operations to copy a file from
OPFS to a temporary location on the native operating system'’s file system so that native applications
can access the data. When you specify vfs: as a prefix of the file name of a COM operation, the path is
automatically replaced in the COM commands with the path to the temporary file. In this way, the COM
operations will interact with the temporary file in the native file system while the LotusScript command

only needs to reference the file in the OPFS.

Lotus- Behavior
Script
functions

NotesSes- FileOpBegin will export the file from the OPFS to a temporary location on the native operat-
sion.File-  ing system'’s file, and this temporary file will automatically be used when you pass the virtu-
OpBegin al file to COM commands.

NotesSes- FileOpEnd will copy the file from the temporary location on the native operating system'’s file
sion.File-  system back to the OPFS.
OpEnd

COM Helper

In order to have HCL Nomad for web browsers successfully process Component Object Model (COM)
calls from agents and buttons, the Windows client machine needs to have HCL Nomad for web browsers
COM Helper installed. COM is a Windows only feature, so the COM Helper only applies to web browsers

running on a Windows machine.

The installer configures Chrome or Edge to load an HCL Nomad COM Chrome extension from the
respective web store and configures the extension to work with the domain specified during the install.

Additionally, the installer lays down a native program that the Chrome extension will leverage. Once


https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EMBEDOBJECT_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_EMBEDOBJECT_METHOD.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_OPEN_METHOD_STREAM.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_OPEN_METHOD_STREAM.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/LSAZ_OPEN_STATEMENT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/LSAZ_OPEN_STATEMENT.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopbegin_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopbegin_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopbegin_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopend_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopend_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopend_method.html
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installed, Domino applications in Nomad for web browsers that make COM calls will flow through the

Chrome extension to the native application.

Install and Uninstall

Follow these instructions to install and uninstall Nomad for web browsers COM Helper.
Install instructions

. Obtain the NonadCOM M5! file from the latest Nomad directory of My HCL Software .
. Save the NomadCOM NSl file to a local folder, for example to your C:\temp folder.

. Navigate to the folder in which you saved the NomadCOM NMSI file.

. Locate and run the NonadCOM MBI installation file.

. Read the Welcome screen and click Next.

. Read and accept the license agreement terms and click Next.

. Accept the default install directory or specify a different installation directory and click Next.

00 N o oA WON =

. Enter the base URL without http for your Nomad server and click Next. For example,
o If your Nomad serveris ht t ps: // mynomadser ver. myconpany. conl nonad/ #, enter
nynonmadser ver . myconpany. com
o If your Nomad serveris ht t ps: // nynonedser ver . nyconpany. com 8043/ noned/ #,
enter mynomadser ver . myconpany. com 8043.
9. On next screen, click Next to install.
10. Select Yes on any prompts to allow install.
11. Close the installer when complete.
12. Must restart the browser (chrome), if running.

13. You can now launch Nomad in your browser to use COM based Notes Applications.

Uninstall instructions

To uninstall, go into Windows Control panel Add/Remove programs, find and double-click on entry "HCL
Nomad for web browsers COM helper", and click on uninstall.

Configuration

After the Nomad for web browsers COM Helper is installed, the default configuration of the browser

extension should be sufficient in most cases, but there are some configuration options if necessary.

Nomad in multiple domains

If you are using the same browser with different Nomad installations in different network domains, you
need to modify the extension to add all the hosts to the allowed list. Make sure to only list hosts from


https://my.hcltechsw.com/
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secure domains that are under your control. Host entries should be just the host name (no https:// prefixes
or trailing slashes). If your host is running on a non-standard port (not 443) you must include it as well.

Exarnple,nytrustedhost.donain2.con19443

The whi telist.json file is created during installation in the installation directory and contains the list
inside of a JSON object.

{ "whitelist": [ "nytrustedhost.donainl.cont, "nytrustedhost.domai n2. com 9443"] }.

Advanced deployment configuration

The COM Helper installer adds some registry entries to configure chrome to install the extension and
properly use the native binary. These may conflict with (be overridden by) windows/chrome policies. You
can modify your policies from these below settings, if necessary:

This registry entry causes Chrome to install the extension from the Chrome web store:

[ HKLM Sof t war e/ Pol i ci es/ Googl e/ Chr one/ Ext ensi onl nst al | Forcel i st]

"1352" =" pkj kl j i keel mapkoof | hchcl f ohcnmm”

This registry entry registers the native binary with Chrome by pointing to the manifest in the install
directory that describes it.

[ HKLM Sof t war e/ Googl e/ Chr one/ Nat i veMessagi ngHost s/ com hcl . nomad. webconj

@"C:\\Program Fi | es\\ HCL\\ HCL Nonmad for web browsers COM hel per\\ mani f est.j son"

You may check what policies are active in Chrome by navigating a browser tab to:
chrome: // policy

Some policies can cause conflicts so please review the following policies to ensure our extension

(pkjkljikeelmnapkooflhchclfohcnmn) and native binary (com.hcl.nomad.webcom) are not blocked:

« ExtensionlinstallAllowlist
« ExtensionlnstallBlocklist
 NativeMessagingAllowlist

 NativeMessagingBlocklist

Examples
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Creating a file and moving it to a specific location on the client computer

' Notes Cient

1. Create file in c:\tnp\um ait. xm

2. Wite file contents

' Nonad for Wb Browsers:

1. Create file in the browser's virtual filesystem vfs:/tnp/unl aut.xn
' 2. Wite file contents

' 3. Make vfs file available to the real filesystem (file in user's tenp directory)
' 4. Use COM object to copy file to c:\tnp\um aut. xm

' 5. Unlink vfs file (delete's tenp file)

' 6. Delete original vfs:/tnp/im adt. xm

Sub Cick(Source As Button)

On Error Goto Handl eError

Di m session As New not esSessi on

DimsPath As String

If session.Platform= "WbBrowser" Then

‘Paths in the browser are like *nix paths with the vfs prefix
sPath = "vfs:/tnp/um aut. xnm "

El se

sPath = "c:\tnp\um adt. xm "

End | f

DimnFile As Integer

nFile = Freefile

Open sPath For Qutput As nFile

Print #nFile, "<TestData></TestData>"
Close nFile

' Keep track of call to FileOpBegin for this file to clean up |later

Di m f SFOB As Bool ean

If session.Platform= "WbBrowser" Then
session. Fi | eOpBegi n sPath, True

fSFOB = True

Dimfso As Variant

Set fso = CreateObject("Scripting.Fil eSystenlbject")
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' COM Hel per will translate sPath used in FileQOpBegin to the tenp file |ocation
' Do not renpve/ nove the tenp file except through calling FileOpEnd. These instructions should be paired.
fso. CopyFile sPath, "c:\tnp\iniadot. xm "

End I f

Final ly:
On Error Goto Handl eFinal | yError
If fSFOB Then
Clean up the tenp file on the native fs before cleaning up the vfs file
' Note: Calling session.FileOBegin on nore than one file in a body of script will require nore conpl ex
' logic than is shown here (a sinple flag) to clean up.
session. Fi | eOpEnd sPat h
If nFile > 0 Then
Kill sPath ' Cean up vfs file
End I f

End I f

Exit Sub

Handl eFi nal | yError:

Msgbox “Error - " & sPath & " - " &nFile & " - " & Error & at line nunber " & Erl
Exit Sub

Handl eError:

Msgbox “Error - " & sPath & " - " & nFile & " - " & Error & at line nunber " & Erl

Resunme Final ly

End Sub

Using Excel to create a spreadsheet and attaching it to a document

' Notes Cient

1. Use excel to popul ate a spreadsheet

2. Save the file to a location on the native filesystem c:\tnp\dnm aat. x|l sx
3. Attach the file to a docunent.

' 4. Delete file in the native filesystem

' Nonad for Wb Browsers:

1. Use excel to popul ate a spreadsheet

2. Save the file to a location on the native filesystem c:\tnp\im adt. x|l sx

‘ 3. Inmport file to the virtual filesystem vfs:/tnp/um aat. x|l sx
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' 4. Attach the file to a docunent.
' 5. Delete file in the virtual filesystem
Sub dick(Source As Button)

On Error Goto Handl eError

Di m sessi on As New not esSessi on

Dim sPath As String

If session.Platform= "WbBrowser" Then
"Paths in the browser are like *nix paths with the vfs prefix
sPath = "vfs:/tnp/um aut. xl sx"

El se
sPath = "c:\tnp\um aat . x| sx"

End I f

' Keep track of call to FileOpBegin for this file to clean up later

Di m f SFOB As Bool ean

If session.Platform= "WbBrowser" Then
session. Fi | eOpBegi n sPath, False ' file does not exist (yet)
fSFOB = True

End |f

Di m excel App As Vari ant

Set excel App = CreateObj ect ("Excel . Application")

Cal | excel App. Wr kbooks. add 'to create new wor ksheet
' Wite out headings

excel App. Cel I s(1, 1).value = "Nane"
excel App. Cel I s(1, 2).value = "SSN'
excel App. Cel I s(1, 3).value = "DOB"

excel App. Cel I s(1, 4).value = "Address"

' Wite out data

excel App. Cel I s(2, 1).value = "John Doe"
excel App. Cel I s(2, 2).value = "123-45-6789"
excel App. Cel I s(2, 3).value = "01/01/2001"

excel App. Cel | s(2, 4).value = "1313 Mcki ngbird Lane / Mockingbird Hei ghts, CA 90046"
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' COM Hel per will translate sPath used in FileOpBegin to the tenp file |ocation
Cal | excel App. Wr kbooks( 1) . SaveAs( sPat h)

Cal | excel App. Wrkbooks. Close ' release the file | ock excel is holding

If session.Platform= "WbBrowser" Then
session. Fil eOpEnd sPath ' inport file into virtual filesystem
fSFOB = False ' we just handled this, so we won't need to clean this up later

End |f

Di m db As Not esDat abase

Set db = session. Current Dat abase

Di m doc As Not esDocunent

Set doc = New Not esDocunent ( db)

doc. Form= "File"

doc.Title = sPath

Dimrti As NotesRichTextltem
Set rti = doc .CreateRichTextlten("FileAttachment")

Call rti.EnbedObj ect (EMBED_ATTACHMENT, "", sPath)

Cal | doc. Save(True, False)

Final ly:
On Error Goto Handl eFinal | yError
Cal | excel App. Qui t
I f fSFOB Then
Clean up the tenp file on the native fs before cleaning up the vfs file
' Note: Calling session.FileOpBegin on nore than one file in a body of script will require nore conpl ex
' logic than is shown here (a sinple flag) to clean up.
session. Fi | eOpEnd sPat h

End I f

Kill sPath ' delete the file that was attached

Exit Sub
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Handl eFi nal | yError:

Msgbox “Error - " & sPath & " - " &nFile & " - " & Error & at line nunber " & Erl
Exit Sub

Handl eError:

Msgbox “Error - " & sPath & " - " &nFile & " - " & Error & at line nunber " & Erl

Resunme Finally

End Sub

Using Excel to create a spreadsheet at a specific location on the computer

' Notes dient

' 1. Use excel to popul ate a spreadsheet

' 2. Save the file to a location on the filesystem c:\tnp\un ait. x| sx
' Normad for Wb Browsers:

' 1. Use excel to populate a spreadsheet

' 2. Save the file to a location on the filesystem c:\tnp\um adt. x|l sx

As you can see, there is no need for any Nonad specific code here if you are not handling
‘" the file with Nomad at all. Prograns accessed via COM can access the native fil esystem
Sub dick(Source As Button)

On Error Goto Handl eError

Di m sessi on As New not esSessi on
DimsPath As String

sPath = "c:\tnp\um aat . x| sx"

Di m excel App As Vari ant
Set excel App = Creat eObj ect (" Excel . Appl i cation")

Cal | excel App. Wr kbooks. add 'to create new wor ksheet

' Wite out headings

excel App. Cel I s(1, 1).value = "Nane"
excel App. Cel I s(1, 2).value = "SSN'
excel App. Cel I s(1, 3).value = "DOB"

excel App. Cel I s(1, 4).value = "Address"
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' Wite out data

excel App. Cel I s(2, 1).value = "John Doe"
excel App. Cel I s(2, 2).value = "123-45-6789"
excel App. Cel I's(2, 3).value = "01/01/2001"

excel App. Cel | s(2, 4).value = "1313 Mcki ngbird Lane / Mockingbird Hei ghts, CA 90046"

Cal | excel App. Wr kbooks( 1) . SaveAs( sPat h)

Cal | excel App. Wr kbooks. Cl ose

Finally:
On Error CGoto Handl eFinal | yError

Cal | excel App. Qui t

Exit Sub

Handl eFi nal | yError:

Msgbox “Error - " & sPath & " - " &nFile & " - " & Error & at line nunber " & Erl
Exit Sub

Handl eError:

Msgbox “Error - " & sPath & " - " &nFile & " - " & Error & at line nunber " & Erl

Resume Finally

End Sub

Sametime Integration
Sametime integration is a feature included in Nomad for web browsers that enables two integration

features with HCL Sametime:

« Unread count badge in the navigation bar. Clicking on the button opens Sametime in a new

window.

'\/ HCL Nomad Open File (’i) Test User1 ~

{2 Home Chat - 2 unread messages
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« Business card pop up with user details and online presence. To open the business card, click on
the name of a contact in the From column in the main Inbox view, Domino directory, or database
document. Sametime chat opens when you click on the Chat button within the business card.

Test Useri
TU Software Engineer

E

51 tuserl@test.com

&, (123) 456-7890

Pre-requisites

« Sametime integration must be configured by the administrator. For more information, see
Configuring Sametime Integration (Nomad for web browsers).

 You must be logged into Sametime web using the same browser as Nomad.

- Authentication to Sametime is handled by Sametime, so an authenticated session must be
established first before using the Sametime integration features in Nomad.

» The HCL Sametime server must be set in the location document in your local nanes. nsf in

Nomad. Administrators may set the value via a policy, or you can manually set the value at


https://help.hcl-software.com/nomad/1.0_admin/config_sametime_integration.html
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names.nsf > Advanced > Locations > Online > Servers > HCL Sametime server. The format

should be just the domain without the ht t ps: // prot ocol, e.g. "sametime.example.com"

W HCL Nomad Open File Edit View Create Actions Text Tools

ol Home E Workspace X 0 Momad's Contacts - Ad. X | & Settings for location: Or X
(=] - -
Connection Configuration Wizard f§§ Save & Close

Location: Online

Basics Servers Ports Mail Internet Browser Replication Instant Messaging Advanced.. Administration

Home/mail server: " MailServer/OrgName

Passthru server: F

Catalog/domain search
server: g

Domino directory server: ™

HCL Sametime server: rsametime.em{ample.cmmJ

Troubleshooting and limitations

The following topics provide information on limitations, troubleshooting tips, and instructions for

reporting problems.

Limitations

There are a variety of limitations for Nomad. Some limitations are short-term, as the function is possible
but has not been implemented yet. Some limitations are long-term and generally involve functions that

cannot be implemented in the environment in which Nomad is running.

Note:

For the Japanese translation of the following limitations, see this article.

All (i0S, Android, web browsers)

Long-term


https://support.hcltechsw.com/csm/ja?id=kb_article&sysparm_article=KB0090718
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- The following Java™-based applications are not supported:
o JavaAgents
o XPages
o LotusScript 2 Java Bridge (LS2J)

» Web services design elements are not supported.

« Dynamic client extensions via native code are not supported. This includes but is not limited to the
following:

> The LotusScript LSXLC and LSXODBC extensions.

- Extensions that require a Dynamic Link Library (DLL). For example, the DXJ name picker
implemented for Windows.

o USELSX is not supported.

» Notes roaming user capabilities are not supported.

- "Forward as attachments" is not currently supported as a mail file action.

« Archiving is not supported.

* Notes Standard Client features and extensions are not included. This code is based on the Notes
Basic Client, so Standard features and extensions are not available. This includes but is not limited
to Recent Contacts, Mail Preview on the side, SwiftFile.

« The following limitations are applicable for all types of hyperlinks: http, ftp and file:

o Hyperlinks typed in a mail body will convert to hyperlinks only if the domain name has at
least 5 characters.

o Hyperlink text containing slashes /' after the domain name in a mail body will converted to a
hyperlink only if the domain name has at least 4 characters.

o There is no minimum length restrictions for domain names if hyperlinks are created from

the Create menu.
Short-term

« All Domino policies are supported. Setup policy settings are applied during first installation and
setup of HCL Nomad, while Dynamic Client Configuration runs second launch onwards. Changes
made to policy settings would be applied on the next launch and not immediately. In addition, not
all policy settings have been fully tested.

« LotusScript class NotesRichTextltem methods Converttohtml and GetHTMLreferences are not
supported and generate errors if used; other NotesRichTextltem methods are supported.

- Notification popups (new mail, alarms, etc.) are not supported.

- Sending mail directly through an SMTP server is not supported when HCL Nomad is configured to
use WebSocket Secure (WSS) connections to the Domino servers. However, HCL Nomad for i0OS
and Android using direct connections to the Domino servers may be able to also make direction
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connections to an SMTP server at which point sending mail directly through an SMTP server
should be possible. For more information, see System Architecture in the Nomad Administrator
documentation.

Android

Long-term

» HCL Nomad does not work with On Demand VPN configurations. If a VPN connection is required
in order to connect to your Domino server, then the VPN connection must be present before using
HCL Nomad to connect to your Domino server.

« Initial setup of the Nomad client using a passthru server connection document is not currently
supported. Once the client's initial setup is complete, a passthru server connection document can

be created and Nomad will use the passthru server as expected.

Note:

ID file synchronization and ID File download are not supported through a passthru server.

« Spell checking support is limited to device spell checking service support.

« Information boxes (application properties, document properties, workspace properties, etc.) are
not supported.

» Some LotusScript and Formula commands associated are not supported. In particular, commands
associated with COM (Component Object Model) such as Object Linking & Embedding (OLE) are
not supported. For more information, see the following topics in the Designer documentation:

o Nomad platform differences in LotusScript®

o Formula Language
Short-term

» @onmand([Fil ePrint]) is not supported.

« Sending mail offline from a local replica of a mail application is not a currently supported action.
» The Notes Workspace is not supported.

« Scheduled Replication is not supported.

« The Create menu is not available.

 Custom actions that are defined for the drop-down action menu are not available.

- Loading remote images of incoming mail with MIME body content is not supported.

- Text in Notes text fields cannot be selected.

- The swipe left and right properties for view actions are not yet supported.


https://help.hcltechsw.com/nomad/1.0_admin/system_architecture.html
https://help.hcltechsw.com/dom_designer/14.0.0/basic/LSAZ_NOMAD_PLATFORM_DIFFERENCES.html
https://help.hcltechsw.com/dom_designer/14.0.0/basic/H_NOTES_FORMULA_LANGUAGE.html
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« LotusScript Include directives are case-sensitive and should use all lowercase letters, such as
"Isconst.Iss".

 Moving columns by dragging the column header is not supported.

« Changing a column'’s size by dragging the column header's edges is not supported.

i0oS
Long-term

« C Api "OSLoadProgram" is not supported on iOS.

 The "View attachment" command uses iOS Quick Look to preview the attached file. Quick Look
renders a preview which may lack the file's full fidelity. It is recommended to open the attachment
in another application that fully supports the file type from the Quick Look view.

« Sharing attachments with other entities such as other iOS applications is not supported.

» HCL Nomad does not work with On Demand VPN configurations. If a VPN connection is required
in order to connect to your Domino server, then the VPN connection must be present before using
HCL Nomad to connect to your Domino server.

* Replication stops when HCL Nomad moves to the background. Keep HCL Nomad in the foreground
while replicating. To view replication status, select the menu button and then select Replication.

« Information boxes (application properties, document properties, workspace properties, etc.) are
not supported.

- i0S Display & Text Size settings do not affect text rendered in Domino applications.

» Some LotusScript and Formula commands associated are not supported. In particular, commands
associated with COM (Component Object Model) such as Object Linking & Embedding (OLE) are
not supported. For more information, see the following topics in the Designer documentation:

o Nomad platform differences in LotusScript®

o Formula Language
Short-term

» @omuand([Fil ePrint]) is not supported.

» The Notes Workspace is not supported.

 Custom actions that are defined for the drop-down action menu are not available.
« Scheduled Replication is not supported.

« The Create menu is not available.

« Scroll bars in Rich Text areas are not visible.

- The swipe left and right properties for view actions are not yet supported.


https://help.hcltechsw.com/dom_designer/14.0.0/basic/LSAZ_NOMAD_PLATFORM_DIFFERENCES.html
https://help.hcltechsw.com/dom_designer/14.0.0/basic/H_NOTES_FORMULA_LANGUAGE.html
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- Initial setup of the Nomad client using a passthru server connection document is not currently
supported. Once the client's initial setup is complete, a passthru server connection document can
be created and Nomad will use the passthru server as expected.

Note:

ID file synchronization and ID File download are not supported through a passthru server.

« Voice dictation is not supported.
» Moving columns by dragging the column header is not supported.
 Changing a column'’s size by dragging the column header's edges is not supported.

Web browsers

Long-term

 No Safari browser support. HCL Nomad is a multi-threaded application. In browsers, multiple
application threads are supported via a SharedArrayBuffer. Safari does not currently support
SharedArrayBuffer, therefore HCL Nomad is not supported on Safari. Previously, Safari supported
SharedArrayBuffer, but this support was disabled in January 2018 due to Spectre and Meltdown
vulnerabilities and has never been re-enabled.

« No Mobile browser support. The mobile versions of the browsers are not supported (even those
that are mobile but use the desktop User-Agent). Only the desktop versions are supported.

« LotusScript classes NotesHTTPRequest (Patch, SetHeaderField, ResetHeaders and
GetResponseHeaders) are not supported.

+ Resources on remote servers (for example, HTTP requests from LotusScript, remote images in
MIME emails, etc.) will not load if the server serving that resource is not Cross-Origin Resource
Sharing (CORS) aware and does not return the expected Access-Control-Allow-Origin header in
the response. This is a restriction enforced by the browser. If the remote server is a Domino HTTP
server, see Configuring cross-origin resource sharing (CORS) in the Domino documentation.

« By default, Change Password for the Notes ID is not supported because Nomad's ID files are
protected with Nomad Shared Login (NSLv3) and do not have a password to change. Therefore,
any server-based password policies regarding password change requirements and password
checking are not applicable. For pre-12.0.2 Domino servers, administrators have 3 choices:

> Disable the server-based password checking feature for Nomad users and consider use
of server-based public key checking as an alternative. For more information, see Using
Nomad Shared Login to suppress password prompts. If Nomad Shared Login is disabled,
the password can be managed under the profile menu.


https://help.hcltechsw.com/domino/12.0.0/admin/conf_cors.html
https://help.hcl-software.com/domino/14.0.0/admin/secu_use_nomad_shared_login_to_suppress_pw_prompts.html
https://help.hcl-software.com/domino/14.0.0/admin/secu_use_nomad_shared_login_to_suppress_pw_prompts.html
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> Continue to use password checking but enable a policy that allows NSLv3 to be used. NSLv3
does not have to be used by all clients, but NSLv3 must be allowed so that the Nomad users
can use it.

> Upgrade all Domino servers to at least 12.0.2.

« Copy/paste with the OS clipboard with Firefox - Only plain text can be copied to the OS clipboard
and nothing from the OS clipboard can be pasted into Nomad. This is a Firefox-specific restriction
because JavaScript code does not allow access to the OS clipboard from the web page.

* Unless you are using panagenda MarvletClient Nomad Roaming, Recent Applications and
Workspace not remembered on data reset or across browsers.

If you have to start over by clearing the browser cache, you will lose any of your Recent
Applications or Workspace changes. Similarly, each browser is independent from each other, so
any changes in Recent Application or Workspace in one browser will not be reflected in other
browsers. One workaround for this is to create a draft mail with doc links to the databases or
documents that you care about most to rebuild the Recent Applications and Workspace links as

necessary.

« Keyboard accelerators/shortcuts - in certain cases, some are handled by the browser instead of
Nomad.

- Depending on the type of editable field in use, such as in a popup dialog, right-clicking on selected
text will not present a context menu.

« If the shortcut key triggers an action in the browser instead of HCL Nomad, try the alternative meta
key instead (Control key on Mac, Windows key on Windows).

» Some LotusScript and Formula commands associated are not supported. In particular, commands
associated with COM (Component Object Model) such as Object Linking & Embedding (OLE) are
not supported except when utilizing the COM Helper. For more information, see the following
topics in the Designer documentation:

o Nomad platform differences in LotusScript®
o Formula Language

- File > Import only supports a subset of formats. Some unsupported formats are still listed in the

file picker dialog. Trying an unsupported format results in errors (for example, Error converting

import file. File cannot be inported.).

For New Mail Message:
> Working file types: ASCII, BMP Image, GIF Image, HTML File, JEPG Image, Microsoft RTF,
Network Portable Graphics, PCX Image, TIFF 5.0 Image, Unsupported File as Text
> Non-working file types: CGM Image, Microsoft Excel, Microsoft PowerPoint, Microsoft Word


https://bugzilla.mozilla.org/show_bug.cgi?id=1619251
https://www.panagenda.com/kbase/display/mc/Nomad+Roaming+Overview
https://help.hcl-software.com/nomad/1.0_web/nomadweb_COMHelper.html
https://help.hcltechsw.com/dom_designer/14.0.0/basic/LSAZ_NOMAD_PLATFORM_DIFFERENCES.html
https://help.hcltechsw.com/dom_designer/14.0.0/basic/H_NOTES_FORMULA_LANGUAGE.html
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= For CGM Image, the following error displays: The executabl e programlibrary
cannot be found.
= For other non-working file types, the following error displays: Error converting
inmport file. File cannot be inported.In some cases, no error displays but the file
does not import.s
For Calendar:
o All file types are supported.
> In some cases, if the calendar contents are not supported, they will not import and no error
message displays.
For Contacts:
o The file picker dialog does not display the appropriate filters to select files. The filter combo
box is empty.

- File > Export only supports a subset of formats. Unsupported formats have been removed from the
file picker dialog.

- File links (file://myfile.txt) links cannot be opened.

» Google Chrome on MacBooks running MacOS Big Sur with hardware acceleration enabled may
cause Nomad to display with odd colors and graphics. While this isn't an issue with Nomad itself,
disabling the System > Use hardware acceleration when available setting in Chrome may work
around the issue.

» When using the "Open in new window" feature:

o Certificate and ECL dialogs can sometimes appear in the previous window. All windows will
be disabled until the dialog is addressed.

o If popups are blocked, and nomad is unable to create a new window, there will be 10 second
delay followed by a message saying Cannot create Pop-up wi ndow.

> Right Clicking an app from the Recent-Apps page, and choosing "Open Link in new Window"
will not work if the "web+notes" service handler is not installed.

- Ability to see Notes database hidden views: in Firefox on Mac OS X, the keyboard combination to
show Notes database hidden views (Ctrl+Shift click) will show the browser's context menu instead
of opening the menu with the modifiers applied.

* Nomad Designer:

» The following design elements cannot be created or edited.
= Java Agents
= Web Services
= Java Libraries
= Applets
= Data Connections


https://developer.mozilla.org/en-US/docs/Web/API/Element/contextmenu_event
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= Composite Applications
= Navigators
« COM Helper:
> Due to security concerns, you cannot directly access any arbitrary file on the Windows
machine from COM code in your agents. Following the examples in these links:

FileOpBegin (NotesSession - LotusScript)

FileOpEnd (NotesSession - LotusScript)

You can let Nomad know about a file you want to access (on the virtual file system):

sessi on. Fi | eOpBegi n("vfs:/tnp/sheet.xls", True).

Note:

Paths in the virtual filesystem look like Linux paths.

When that is done, the contents of the file in the virtual file system are copied to a temp

directory for the user of the Windows machine.
After this, COM will be able to reference that file to work on (just keep using the same path).

When you are done with the file, call sessi on. Fi | eQpEnd("vfs: /tnp/sheet.xls"). The
modified temp file will be transferred back to the virtual file system where it can be attached

to a note or manipulated with agent code.

If you expect to call COM and create a file, pass False instead of True to Fi | epBegi n. .
Short-term

» Nomad Designer code editors do not support displaying line numbers.

- In Nomad, scheduled replication can be enabled and disabled on the Replication tab, but the
schedule cannot be edited on the Replication tab. The schedule can be set in other ways and
pushed to the Nomad client; in Nomad, the schedule can be edited via the Location document in
the local address book (names.nsf).

» NotesDominoQuery is not supported.

» Document Printing Support.

> View printing is not supported.
 There is a limitation on the maximum number of pages and it is based on the browser and

platform combination.


https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopbegin_method.html
https://help.hcl-software.com/dom_designer/14.0.0/basic/H_fileopend_method.html
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o Pagination is handled by the browser. Images or text may be split across pages. Users may
need to use the browser print settings (custom margins or scaling) to achieve the desired
print output.

» Print must be accessed using Nomad's menu or shortcut. The browser's Print functionality
is not supported.

o Custom header and footer is not supported.

o Printing multiple documents from a view is not supported.

+ Dialogs are not resizeable.

 The "Open in New Window" context menu item is grayed out on Workspace tabs and does nothing
in the body of an already open document (close the document and go back to the view to open the
document in a new window).

- Grid Style property for views: Dashed, Dots, or Dashes and Dots grid styles are not currently
supported and grids will be rendered with Solid style.

« Web components (for example, combo boxes, scroll bars and dialog buttons) are always rendered
on top of canvas components. One example of where this may be noticed is when scrolling a
document that has a combo box that should be partially hidden by a toolbar (a canvas component)
but instead the combo box is shown on top of the toolbar. Another example is where a tooltip (a
canvas component) is shown with a web component on top of the tooltip.

« Limited font renderings when using Firefox. Only the fonts shipped with Nomad (one font each for
Monospace, Sans and Sans-Serif typefaces) are used for rendering purposes.

- Attachments that cannot be rendered by the browser are download only. There are no attachment
viewers and attachments cannot be launched. You can save an attachment to the local file system
and then use any OS application to view the attachment.

« Copy/paste with the OS clipboard with Chrome and Edge:

o If both text and an image are copied in Nomad, the OS clipboard separates the text from the
image and paste appears to prefer the image over the text resulting in only the image being
pasted.

- If a document has multiple images, copying each image puts the same image on the
0S clipboard, causing the paste to not always match what was copied. For example, if a
document has three images, pasting may always be the second image no matter which of
the three images was copied by the user.

> When pasting from outside of Nomad, only single images or text can be pasted. Rich text
and multiple images are not supported.

« COM Helper:

COM Helper is only supported on Google Chrome on operating systems that support COM
(Microsoft Windows).
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Troubleshooting

If you are encountering issues with HCL Nomad for web browsers, complete the following steps (in order)
to try to resolve your issue.

Note:

For information on setting notes.ini values, see Setting notes.ini values in the Nomad

Administrator documentation.

Setup issues

1. Double check your browser configuration (on page 20) and re-start the browser.

2. If the page does not load, sits at "Starting up" for more than a minute, or you get the Fail ed to
regi ster service worker message, check your HTTPS setup and any proxies that exist between
the web browser and HCL SafeLinx.

- HCL Nomad uses service workers in the browser and the browser requires a trusted HTTPS
connection to enable service workers. HTTPS needs to use a signed certificate that is
trusted by the browsers. If a signed certificate is not available, a self-signed certificate
may be used but requires every browser endpoint to trust that certificate at the browser
and/or operating system level - ensure that the self-signed certificate meets the browser's
requirements such as a Common Name that matches the host name and providing the
Subject Alternate Name (SAN).

> HCL Nomad uses service workers in the browser. Service workers must be able to
successfully download all of the resources to complete registration. Check the network
flows for errors such as The server responded with a status of 502 (Proxy Error) or
errors where the Server HTTP response header is something other than Nomad Server.
Ensure that any proxy relays all /nomad requests to HCL SafeLinx.

3. If you get either the The information provided by the Nomad proxy server was inconplete or
invalid. ORthe Your IDfile could not be found on the server. Nomad setup requires that
your IDfile be available in the ID vault on the server. message during startup, test what
the proxy server returns by trying the / nomad/ user Confi g. j son URL. This should return the user and
server names. If either of those values is missing or incorrect, contact your administrator to correct
the search being done against Domino to obtain those values.

4. If yougettheFailed to install service worker. message during a first-time setup, it is
most likely caused by a non-trusted SSL/TLS certificate or incorrect HTTP headers. Without
proper headers, service workers are not allowed due to security reasons. To resolve this issue,


https://help.hcltechsw.com/nomad/1.0_admin/nomad_set_notesini.html

10.
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review Hosting the Nomad for web browsers static web files (on page ) and the System

Requirements (on page 18).

.IfyougettheFailed to install service worker message outside of a first-time setup (in the

browser console, this may appear as Cache. put () encountered a network error), it is most likely
caused by a lack of disk space on the machine. The browser needs to download the new files while
the existing files are running, which produces two copies of the files until the update is complete.

Check the machine's disk space and ensure at least five gigabytes are free.

. If you get a cannot GET /nomad/ message, it may be due to the Accept-Encoding HTTP header

being removed by something in the network flow. Check that the Accept-Encoding HTTP header is
getting to the Nomad server.

. If you repeatedly get prompted to Log In and the console log contains "Authentication: user check

failed", the / nonmad/ user Conf i g. j son response may be missing some information. The JSON
response should contain at least userCN and homeServerCN and the values for both should be
non-empty; for example:{ "user CN': " MyCanoni cal Nane/ MyDomai n", " hormeSer ver CN": " MyMai | Ser ver/
M/Domai n"}.You can test this in the browser outside of HCL Nomad by directly going to / nomad/
user Confi g. j son and viewing the response.

. If your environment is set up for SSO and Nomad is prompting for log in, despite another

application in the same browser already being logged in (such as Verse, Sametime, Connections,
etc.), your LTPA token trust settings in Nomad may not be set as desired. For more information, see

Troubleshooting (SafeLinx) in the Nomad Admin documentation.

. In Chrome, if Nomad is not opened in a PWA window, if you do not get the option to "Install HCL

Nomad" or "Open in HCL Nomad", you may need to close Chrome and delete the following cache
files from your system:

For Windows:
o C:\ User s\ <user nane>\ AppDat a\ Local \ Googl e\ Chr one\ User Dat a\ Def aul t\ Cache\ *
° C:\ User s\ <user nane>\ AppDat a\ Local \ Googl e\ Chr one\ User Dat a\ Def aul t\ Code Cache\*

o C:\ User s\ <user nane>\ AppDat a\ Local \ Googl e\ Chr one\ User Dat a\ Def aul t\ St or age\ *

For Mac:

o ~/ Li brary/ Caches/ Googl e/ Chr one/ Def aul t/ Cache/ *
o ~/ Li brary/ Caches/ Googl e/ Chr one/ Def aul t/ Code\ Cache/ *
o ~/ Li brary/ Caches/ Googl e/ Chr one/ Def aul t/ St or age/ *
If you are attempting to use Nomad Federated Login and are still getting prompted for the Notes ID

password, check the following in the Nomad console log via the browser's tools:


unique_36
unique_36
unique_36
https://help.hcltechsw.com/nomad/1.0_admin/troubleshooting_safelinx_nomad.html
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o userConfig.json needs to include deployNSF pointing to the deploy.nsf file on the
server. For example: {"userCN': "Jane Doe/ MyDomai n", "honeServer CN': " MySer ver/
MyDonei n", "depl oyNSF": "/ nomad/ conf i g/ depl oy. nsf"}

o If you do not have a wasmHandleSamlAuth entry with the "Auth URL', then the server is
not configured properly to instruct the client to use Nomad Federated Login. For more
information, see Nomad federated login in the Domino documentation.

11. "Nomad Setup Error": If this error appears, check the browser console for a more detailed
explanation. It could be caused by the following:

> The Home server is not available, or cannot be reached.

> A misconfiguration in Safelinx or Nomad server. For more information, see Configuration

options for the Nomad server for Dominoin the Nomad Administrator documentation.

Sametime integration issues

If Sametime business cards are no longer opening, and the chat icon button in the nav bar is displayed
with a slash through it, then re-authentication with Sametime is required. Click the chat icon button in the
navigation bar to open Sametime to login. Once logged in, navigate back to Nomad. You should now be
authenticated. The slash in the chat icon button should no longer be present and an unread badge should
appear in the navigation bar if you have any unread Sametime messages.

COM issues

Logging for the helper is a bit more complicated than looking in the browser console.


https://help.hcltechsw.com/domino/12.0.0/admin/configuring_nomad_federated_login.html
https://help.hcltechsw.com/nomad/1.0_admin/config_options.html
https://help.hcltechsw.com/nomad/1.0_admin/config_options.html
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1. Create a new shortcut to launch chrome and append - - enabl e- 1 oggi ng --v=1 to the end of Target.

= =5 ‘_ﬁ
".? Google Chrome Properties x
Security Details Previous Versions
General Shorteut Compatibility Digital Signatures

‘. Google Chrome

A

Target type: Application
Target location: Application

Target: e'Applicationchrome exe” —enabledobging —v=1

Start in: "C:\Program Files'Google Chrome\Application™

Shortout key:  [Mone |

Run: Momal window e

2. Ensure there is a space before the - -.
3. Relaunch Chrome using the shortcut.

This will cause a console window to appear with the Chrome browser.
Logs for the helper will appear in the new console window.

To enable verbose logging for the COM helper:

1. Create a file named debug (with no extension) in the install directory.

2. The content of the file does not matter, only its presence.

3. The verbose debugging can cause performance degradation with COM operations, so admins
should remove it when not needed.

General issues

1. Reload the Nomad page.

2. Restart the browser and reload the Nomad page.

3. Double check your optional browser configuration settings (on page 23).

4. If you are having connection issues to a particular Domino server, you can run

j sNet wor kTrace(' nyser ver/ nydonai n' ) in the browser console to test network connectivity to that
server.
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5. If previous steps have not resolved the issue, you may attempt to start from scratch by cleaning
up the browser and starting over. If the initial setup fails at any point, reloading the Nomad page
performs an implicit reset of the browser data, so a manual reset should not be necessary. For

more information, see Browser configuration (on page 20).
Firefox

o If you ARE on the Nomad page in a tab, click the padlock icon in the address bar Clear

Cookies and Site Data > Remove.

o If you ARE NOT on the Nomad page in a tab, click the Firefox menu in the OS or the
3 bar menu normally found to the right of the address bar Preferences > Privacy
and Security > Cookies and Site Data > Manage Data > Pick the Site (for example,

mysafelinxserver.mycompany.com) > Remove Selected > Save Changes > Remove.

Chrome

o If you ARE on the Nomad page in a tab, hit the padlock icon in the address bar Site Settings

> Clear data > Clear.

o If you ARE NOT on the Nomad page in a tab, click the Chrome menu in the OS or the 3 dot
menu normally found to the right of the address bar Settings > Privacy and Security > Site
Settings > View permissions and data stored across sites > Pick the Site (for example,
mycompany.com) > Pick the Site (for example, mysafelinxserver.mycompany.com) > Clear

data > Clear.

- N
Note:
In the browser's Developer Tools Application - Application - Storage, there is a Clear
site data button, but this button is insufficient because it does not clear the File

System data. To completely clear the site data, follow the above instructions.

Edge
o In the Edge menu in the OS or the 3 dot menu normally found to the right of the address bar,
complete the following steps:
= Settings > Cookies and Site Permissions > Manage and delete cookies and site data
> See all cookies and site data > Cookies and site data. Expand the section for the
site (for example, mysafelinxserver.mycompany.com) and click the trash icon for the

site.
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o ™
Note:
In the browser's Developer Tools Application - Application - Storage, there is a Clear
site data button, but this button is insufficient because it does not clear the File
System data. To completely clear the site data, follow the above instructions.

Note:

Unlike Firefox and Chrome, where there is a shortcut if you are on the Nomad for

Web Browsers page, you must use this method in all cases on Edge.
N J

Reporting a problem

If you experience a problem with the HCL Nomad application, you need to provide a clear description of
the problem (including the date and time of the problem along with screen shots and/or logs), information
on your browser environment (what browser and what browser version), and information on your server

environment (any proxies, any firewalls, Nomad web proxy/SafeLinx, and Domino).

To obtain logs for a clear description of the problem, complete the following steps:

1. Reproduce the issue with HCL Nomad. Take screen shots of any errors, unexpected behaviors, etc.
2. Create a zip file of the logs that you download to your local machine and then provide to support
with one of the following options:
> Generate Problem Report

While Nomad is running, navigate to the Help menu and select Generate Problem Report.
This creates a zip file of the logs that you download to your local machine and then provide
to support. Some error dialogs will also have a Generate Problem Report button to generate
the zip file.

> nprDownload() command
If Generate Problem Report is not available and you do not have a dialog with a Generate

Problem Report button, issue nomad.nprDownload() in the browser's console to generate
the zip file of the logs that you download to your local machine and then provide to support.
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= In Firefox, the Console is accessed via the 3 bar/hamburger button normally found to

the right of the address bar: More Tools > Web Developer Tools.

= In Chrome and Edge, the Console is accessed via the 3 dot button normally found to
the right of the address bar: More Tools > Developer Tools. If you are running as a
Progressive Web Application, use the 3 dot button and select Open in Chrome to get

back to Chrome (from which you can open the Developer Tools).

If both options fail, the error occurred before nomad.nprDownload() could be initialized, so just

continue to the next step.

3. Because the browser writes message directly to the console in a manner that HCL Nomad cannot
capture in the Problem Report, it is also recommended to provide the Console log to support.
Follow the instructions in step 2 -> nprDownload() command to open the Console and then save

the contents as follows:

To Get Web Console logs:
> In Firefox, control (right) click inside the console and select Save all Messages to File.
> In Chome and Edge, control (right) click inside the console and select Save As...

4. (Optional) If the problem is related to network connectivity, HTTP headers or file downloads, a
network trace may be helpful. Follow the instructions in step 2 -> nprDownload() command to
open the Console and then switch to the Network tab (this must be done before recreating the
problem as the network traffic, unlike the console, is only captured while the tools are open). Save

the network trace as follows:

o In Firefox, click on the gear icon (Network Settings) and select Save All As HAR.

> In Chrome and Edge, click the down arrow icon (Export HAR...).

Administering Nomad for web browsers

See the Administrator documentation for more information.


https://help.hcltechsw.com/nomad/1.0_admin/index.html
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